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1. General

1.1 Introduction
This is the user’s manual of ThermaCAM Researcher 2001. We are convinced
that this program will be a useful tool when you explore the fascinating world of
Infrared Imaging and Measurements.

ThermaCAM Researcher has two hardware configurations, a PC Card camera
interface and a Parallel camera interface. Both interfaces are used for several types
of cameras. The manual covers both configurations and all cameras. Please make
sure that the information you read is about the right camera with the right type of
camera interface.

In the manual, you should be able to find detailed answers to these three types of
questions:

• What kind of hardware and software is used? How is it to be installed?

• What is the software and Thermography like, in general?

• How should I use ThermaCAM Researcher, to get some particular result?

Since this is more like a reference manual than a tutorial, there will be rather
detailed answers to those questions. It means that you probably only will study the
manual in parts from time to time.

If you need the manual, but cannot find it, you can rely on that the same
information is available as the help text of the program.

1.2 News in ThermaCAM Researcher 2001
Major new features, compared to ThermaCAM Researcher 2000 March Edition:

• The PC Card Interface can now be used on Windows 2000 and Windows
Millennium.

• The images produced when connected to a new ThermaCAM SC 2000 will
not be leaning strongly to the right.

• You can now set a default session. (A session which is read when the program
starts.) See Session files on page 42.

• Bendable lines now exist as a measurement tool on the IR images. See The
line tool on page 84.
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• Object signal presentation can now be selected from the IR Image Settings.
See Units of measure on page 39 and Measurement output and units, page 94.

• Images can now be saved in a FLIR Public Image Format , described in this
manual. See The FLIR Public image format on page 97.

• Images saved in the Matlab file format , will now also have information
about the image, in addition to the point values. See Studying whole images
with Matlab on page 96.

• Temperature or Object signal Subtraction of selected image files is now
available in the Recording menu. Two new special purpose palettes exist,
intended for difference images. (midgreen and midgrey) See Subtracting
selected images on page 77.

• A new palette tool button has been added to the standard tool bar.

• The image replay rate can be set via the new “*1” control on the play images
toolbar. See The play images tool bar on page 72.

• Trig counts stored in the images are now displayed on the play images tool bar
and in the result table. They are also available as OLE links. Plotting on stored
trigs is also possible. See The Replay Settings dialogue on page 73 and How to
trigger ThermaCAM Researcher from outside on page 63.

• Formulas can be applied to analysis results. An “f(x)” button has been added
to the analysis tool bar. See The Formula tool on page 84.

• The IR image now has menus brought up by clicks on the right mouse button,
through which its settings can be changed. The area symbol in focus will now
highlight when the mouse cursor is moved in the IR-image.

• The mathematics that corrects for the effects of emissivity and atmospheric
attenuation can now also handle external optics. See External optics
transmission and temperature on page 38.

• For ThermaCAM SC 3000 cameras with a high-speed option, the image speed
can be set from the camera control. See
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The THV 500 Camera Control on page 54.

• Striped burst volumes can be moved between Windows 2000 computers. See
Windows 2000 striped volumes on page 29.

1.3 Copyright
© by FLIR Systems AB, 1997-2000. All rights reserved worldwide. No parts of the
software including source code may be reproduced, transmitted, transcribed or
translated into any language or computer language in any form or by any means,
electronic, magnetic, optical, manual or otherwise, without the prior written
permission of FLIR Systems AB, Box 3, SE-182 11 Danderyd, Sweden.

This manual may not, in whole or part, be copied, photocopied, reproduced,
translated or transmitted to any electronic medium or machine-readable form
without prior consent, in writing, from FLIR Systems AB.

1.4 Warranty
FLIR Systems AB computer software is supplied as is and FLIR Systems accepts
no responsibility or liability and makes no warranties whatsoever whether
expressed or implied with regard to the same, including but not limited to its
quality, performance, merchantability or fitness for a particular purpose.

All products manufactured by FLIR Systems AB are warranted against defective
materials and workmanship for a period of one (1) year from the delivery date of
the original purchase, provided such products have been under normal storage, use
and service, and in accordance with FLIR Systems’ instruction.

All products not manufactured by FLIR Systems included in systems delivered by
FLIR Systems to the original purchaser carry the warranty, if any, of the particular
supplier only and FLIR Systems has no responsibility whatsoever for such
products.

The warranty extends only to the original purchaser and is not transferable.

It is not applicable to any product, which has been subjected to misuse, neglect,
accident or abnormal conditions of operation. Expandable parts are excluded from
the warranty.

In the event of a defect in a product covered by this warranty the product shall not
be further used in order to prevent additional damage. The purchaser shall
promptly report any defect to FLIR Systems or this warranty will not apply.

FLIR Systems will, at its option, repair or replace any such defective product
without charge if it, upon inspection, proves to be defective in material or
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workmanship and provided that it is returned to FLIR Systems within the said one-
year period.

FLIR Systems has no other obligation or liability for defects than above set forth.

No other warranty is expressed or implied. FLIR Systems specifically disclaims the
implied warranties of merchantability and fitness for a particular purpose.

FLIR Systems shall not be liable for any direct, indirect, special, incidental or
consequential loss or damage, whether based on contract, tort or any other legal
theory.

1.5 Quality assurance
The Quality Management System under which these products are developed and
manufactured has been certified in accordance with the standard for ISO 9001.

1.6 Trademarks
AGEMA and ThermaCAM are trademarks, and Thermovision® is a registered
trademark of FLIR Systems.

Microsoft® and MS-DOS® are registered trademarks and Windows is a
trademark of Microsoft Corporation.

MATLAB® is a registered trademark of The MathWorks, Inc.
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2. PC Card Interface configuration

2.1 System parts ThermaCAM SC - PC Card Interface
This configuration is used for the following camera models:

Thermovision 550, Thermovision 570, AGEMA 550, AGEMA 570,
ThermoVision Alert, ThermaCAM SC 500, ThermaCAM SC 2000 and
ThermaCAM SC 3000.

Note: It is not used for ThermaCAM SC 1000.

Breakout cable 5m PC-card cable 2.5m

Break-
out

194091

194240

194257

PC-
card

Extension Cable

10m

194267

Power 500/900

The extension cable may be

connected at A or B

A
B

Max 17.5m

Figure 1: ThermaCAM SC - PC Card Interface system parts

• A BreakOut Box (194 257).

• A PC Card Interface 500 (194 240). A PCMCIA-standardised card with a
cable that fits into the “Remote” connector on the BreakOut Box.

• A Power Supply 500/900 (194 091).
(A ThermaCAM 5xx battery pack can also be used.)

• An optional Extension cable.

• The ThermaCAM Researcher CD-ROM (not shown) including PC driver
software.
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Note: For ThermaCAM SC 3000, the BreakOut Box can be omitted. Instead,
connect the power supply cable to the Power inlet of the camera and plug the PC
Card Interface into the Data connector of the camera, like this:

PC-card cable 2.5m

194091

194240
PC-
card

Power 500/900

P

D

Figure 1a: ThermaCAM SC 3000 - Alternative configuration

Please make sure that the cables are connected in the right way. The
connectors are of the same type, so you might make mistakes when connecting
these cables. That cannot, however, harm the hardware.

Beware: You must not use the serial port connector (DSUB) of the Break-Out Box
while the PC Card Interface is connected to it. That could harm the camera.

The computer side of the PC Card Interface has to be treated with care, since it is
quite vulnerable to damage.

Please read Installing the driver software for the PC Card interface on page 16 as
well.
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2.2 System parts ThermaCAM SC 1000 - PC Card Interface
This configuration is used for only one camera model: ThermaCAM SC 1000.

Breakout cable 5m

PC-card cable 2.5m

Break-
out

194091

194240

194257

PC-
card

Extension Cable

10m

194267

Power 500/900

The extension cable may be

connected at A or B

A

B

Max 17.5m

Dig.
I/F DA

TA
O
UT

CA
M
ER
A
P
O
W
ER

15824-200

Figure 2: ThermaCAM SC 1000 - PC Card Interface system parts

• A SC 1000 Digital Interface Box (15824-200) with cables that connect to the
SC 1000 battery connector, digital output connector and remote connector.

• A BreakOut Box (194257) with a cable that fits into the SC 1000 Interface box.

• A PC Card Interface 500 (194240). A PCMCIA-standardised card with a
cable that fits into the “Remote” connector on the BreakOut Box.

• A Power Supply 500/900 (194091).
(A ThermaCAM 5xx battery pack can also be used.)

• An optional Extension cable (194267).

• The ThermaCAM Researcher CD-ROM (not shown) including PC driver
software.

Please make sure that the cables are connected in the right way. The
connectors are of the same type, so you might make mistakes when connecting
these cables. That cannot, however, harm the hardware.

The computer side of the PC Card Interface has to be treated with care, since it is
quite vulnerable to damage.
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Please read Installing the driver software for the PC Card interface on page 16 as
well.

2.3 System parts Thermovision® 900 PC Card Interface

PC-card

194091

Scanner cable
2.5m

PC-card cable
2.5m

194261

PC-
card194243

Extension cable 7.5m

193424 Extension Cable may be
connected at A (or B If

retainer bolts are modified)

Power 500/900

A B

Power
Scanner

Sc.

Po

r

Max 10m
Max 50m

we

Figure 3:Thermovision® 900 PC Card Interface system parts

• A PC Card Interface 900 (194243): A PCMCIA-standardised card with a
cable that fits into the side of the Power Scanner box.

• A Power Scanner 900 box (194 261).

• A Power Supply 500/900 unit (194 091).

• An optional Extension cable (193424)

• The ThermaCAM Researcher CD-ROM (not shown) including PC driver
software.

The computer side of the PC Card Interface has to be treated with care, since it is
quite vulnerable to damage.

Please read Installing the driver software for the PC Card interface on page 16 as
well.
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2.4 System parts Thermovision® 1000 PC Card Interface

PC-card cable 2.5m

193930

PC-
card

28VDC

194077 7.5m

Figure 4 Thermovision® 1000 PC Card Interface system parts

• A PC Card Interface 1000 (193930): A PCMCIA-standardised card with a
cable that fits to the Thermovision 1000 scanner.

• The ThermaCAM Researcher CD-ROM (not shown) including PC driver
software.

The computer side of the PC Card Interface has to be treated with care, since it is
quite vulnerable to damage.

Please read Installing the driver software for the PC Card interface on page 16 as
well.

2.5 Hardware limitations
Due to hardware and software driver limitations only one PC Card Interface
500/900/1000 can be inserted and functional at the same time. If you try to insert a
second PC Card Interface, a hardware resource conflict will occur and the second
card will not be configured correctly, which is indicated with a single low pitch
beep.

2.6 Software limitations
The PC Card Interface configuration works on Windows 95, Windows 98,
Windows Millennium, Windows NT 4.0 (with service pack 3 or higher) and
Windows 2000. You might need a service pack on Windows 2000 to get your PC
Card Adapter to work properly.
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2.7 PC recommendations
To get a reasonably high performance you should have a Pentium desktop or
laptop computer with a clock rate of 200 MHz or more. It should also have a fast
display adapter and a fast hard disk.

Our recommendation is to set the Colour palette to 256 Colours. True Colour gives
a lower frame rate, but better colour fidelity.

2.8 Installing the driver software for the PC Card
interface

2.8.1 Windows NT 4.0
Please log in as Administrator during this installation.

First, install CardWare 6.00.007 (or higher), that allows you to insert and remove
PC Cards while Windows NT 4 is running.

Then, insert the ThermaCAM Researcher CD-ROM into your CD drive. The CD-
ROM will show a window of its own from which you can select to install
Windows NT drivers. Start that installation utility and select "PC Card Interface"
drivers only. Do not select any other drivers!

The installation utility will copy some files and update the Windows Registry.

2.8.2 Windows 2000
How to install the driver

Insert the PC Card Interface into the card adapter.

Windows 2000 will now detect the new hardware and display a New Hardware
Found message together with a wizard dialogue. Insert the ThermaCAM
Researcher CD-ROM into your CD drive. The CD-ROM will show a window of its
own, but just remove that by clicking Exit. Follow the wizard instructions. When
the wizard asks for search locations, check the CD-ROM drives option. In the last
wizard step you should hear a double beep from the computer indicating that the
resource allocation was successful.

Windows 2000 will then continue to install a second device, which is the
imaging device. During the installation of this device, Windows 2000 will
display a sign saying Digital Signature Not Found. Answer Yes here.

The third and last device installed is the communications port.
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How to update an existing driver

Insert your PC Card Interface and your ThermaCAM Researcher CD-ROM.
Remove the appearing CD-ROM window.

Go to the Control Panel and open the System icon and select the Hardware tab.
Click on the Device Manager button:

Open Imaging devices and double click on the PC Card Interface and
then select the Driver  tab. Click on Update driver.

Follow the instructions and when the wizard asks you what to do, select the
Display a list… option and then click on the Have disk… button to make
Windows read the driver from the CD-ROM. Select the appropriate driver from the
list.

2.8.3 Windows 95/98/Millennium
How to install the driver

Insert the PC Card Interface into the card adapter. Windows 95/98/ME will now
detect the new hardware and display a New Hardware Found message together
with a dialogue. Insert the ThermaCAM Researcher CD-ROM into your CD drive.
The CD-ROM will show a window of its own, but just remove that by clicking
Exit. (If you have Windows 95 version A then select the alternative Driver from
disk provided by hardware manufacturer and click OK, otherwise follow the
wizard guide.) You should hear a double beep from the computer indicating that
the resource allocation was successful.

Windows 95/98/ME will then continue to install the second device, which is the
communications port. Windows 95/98/ME will display a sign saying Unknown
device, which is quite all right. During the installation of the second device,
Windows 95/98/ME may ask if you want to overwrite the communications port
driver software provided by Microsoft. Please do not replace the existing one.

During the installation of the third and final device, the image device,
Windows 95/98/ME will again display a sign saying Unknown device.

How to update an existing driver

If you have previously installed a device driver for a PC Card Interface, you may
now need to update your driver.

Insert your PC Card Interface and your ThermaCAM Researcher CD-ROM.
Remove the appearing CD-ROM window. Go to the Control Panel and open the
System icon and select Device Manager:
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Open Multi-function adapters  and double click on the PC Card
Interface and then select the Driver  tab. Click on Update driver. Follow
the instructions to make Windows read the driver from the CD-ROM. It
takes a while for Windows to install the driver.

It may well happen that Windows does not find any new driver to load on the CD-
ROM. This is quite OK, if you already have the most recent drivers.

2.9 Optimising the driver installation
The optimising option is only available if the PC Card interface is used under
Windows 95/98/ME. The PC Card adapter in your system is initialised by the
operating system. Three additional wait states are added to each memory access by
default. Memory accesses are used by ThermaCAM Researcher to transfer images
from the PC Card interface to the system memory.

If you have an Intel PCIC compatible controller in your PC Card adapter you can
try to optimise the image transfer speed by reducing the number of PC Card
memory wait states. Before you try this, make sure you have a PCIC compatible
controller. This information can be found in the System Device Manager (Control
Panel), under PCMCIA socket device properties. If you have a PCIC compatible
controller from Cirrus Logic, it will require a different kind of optimisation
compared to controllers from other vendors.

After you have installed ThermaCAM
Researcher, select Optimise from the
camera control panel. This dialogue box
will then appear:

Check the "Enable optimisation" check box. Select the appropriate adapter type.
The most common type is "Intel PCIC Compatible". Try with 0 wait states first. If
you still have a live image the optimising is successful, otherwise go back to the
dialogue and increase the number of wait states. Repeat this until you have a live
image again.
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2.10 Troubleshooting the PC Card installation
Problems with the PC Card Interface and its installation don’t always show up
immediately. You might not notice them until you try to get a live image from the
camera.

Our experience is that hardware installations do not always run smoothly. A
number of detailed suggestions on how to overcome known difficulties are
available in an “InstHints” document on the ThermaCAM Researcher CD-ROM.

To work properly, the PC Card Interface configuration needs:

• A correct “Type of camera” and “Type of connection” setting in the Select
Camera dialogue.

• One of the fixed I/O space range (3f8-3ff, 2f8-2ff, 3e8-3ef or 2e8-2ef).

• Interrupt request (IRQ) 3,4,5,7,9,10,11,12 or 15.
An ISA-type interrupt is required, even for PCI bus adapters.

• A 4 kByte window in the computer memory.

• The fix addresses 380 to 387 in the computer I/O space.

• CardWare 6.00.007 (or higher) on Windows NT 4.0 installed by an
administrator.

• Software for the three device drivers in Windows 95/98/ME/2000, just one
on Windows NT 4.0.

• A successful installation of ThermaCAM Researcher.

• A functional PC Internal Card Reader on an ISA or PCI bus.

• A functional PC Card Interface.

• Reliable cables and electrical connections.

• A camera equipped with digital output.

The most frequent difficulties occur on laptop computers with lots of fancy
equipment that occupy the scarce computer resources. Installation problems, such
as only partly successful device driver installations are also rather frequent. Not to
mention plain cabling problems.
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This fairly simple troubleshooting scheme may help you locate your problem:

• When you insert the PC-Card Interface, you should hear a “happy” sound.
If you don’t hear any sound at all or a “sad sound” there migh be something
wrong with the PC Card Adapter (or its BIOS settings) or the installation of
the drivers or a resource conflict.

• If you get a “happy” sound but ThermaCAM Reserarcher says Disconnected,
one might still suspect the device driver installation. Only the presence of the
first (out of three) device drivers is required to get a “happy” sound. Other
possibilities are a resource conflict or that another instance of ThermaCAM
Researcher already is connected to the camera.

• ThermaCAM Reserarcher does try to establish a connection with the camera
using the serial communication port before trying to capture any images.
If you get the Connecting… status text without any reply from the camera,
there could be cabelling problems or problems with the BIOS settings for the
PC Card Adapter or, simply, the wrong type of camera or connection type.

• If you get a serial connection to the camera (ThermaCAM Researcher says
“Connected”) but no image, there might be some problem with the camera
(such as insufficient cooling or hardware) or problems with the image flow
(i.e. cabelling problems) or a computer memory window resource conflict.

For more information on how to deal with these matters, please check the InstHints
document on the ThermaCAM Researcher CD-ROM.



ThermaCAM Researcher 2001 Operating Manual

21

3. Parallel Interface configuration

3.1 System parts ThermaCAM SC Parallel Interface
This configuration is used for the following camera models:

Thermovision 550, Thermovision 570, AGEMA 550, AGEMA 570,
ThermoVision Alert, ThermaCAM SC 500, SC 2000 and SC 3000.

IC2dig16

RS232

SCSI

500 Camera

cable 2.5m

HDD

Optional ext trig.

RS422

RS232
194452

908618

194441

194091

194450

Extension Cable

10m

194267

Max
17.5m

PC

Power
500/900

1.8m

1.8m

Max

6m

PI 500/900
500

pwr
900 422232

Figure 5 ThermaCAM SC parallel interface system parts

• IC2-DIG16 frame grabber (in the PC) from Imaging Technology Inc. in
USA: A PCI-standardised card with a 44-pin DSUB cable that fits into the side
of the Parallel Interface (PI). A standard RS 232-C cable that connects a
serial port in the PC with the Parallel Interface.

• A Parallel Interface (PI) 500/900 box (194 441).

• Camera cable 500 (194 450). For ThermaCAM SC 3000, plug this cable into
the Data connector of the camera (not into the power inlet).

• A Power Supply 500/900 unit (194 091).

• An optional Extension cable (194 267)

• The ThermaCAM Researcher CD-ROM (not shown) including PC driver
software.

• A desktop computer with two striped SCSI disk for image storage.

Please read Installing the driver software for the IC2-DIG16 on page 30 as well.
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3.2 System parts ThermaCAM SC 1000 Parallel Interface
This configuration is used only for one camera model: ThermaCAM SC 1000.

IC2dig16

RS232

SCSI

HDD

Optional ext trig

RS422

RS232
194452
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194441
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500 Camera cable 2.5m
 194450
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1.8m

1.8m

Max 6m

PI 500/900
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900 422232
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Figure 6 ThermaCAM SC 1000 parallel interface system parts

• A SC 1000 Digital Interface Box (15824-200) with cables that connect to the
battery connector, digital output connector and remote connector of the SC
1000.

• IC2-DIG16 frame grabber (in the PC) from Imaging Technology Inc. in
USA: A PCI-standardised card with a 44-pin DSUB cable that fits into the side
of the Parallel Interface (PI). A standard RS 232-C cable that connects a
serial port in the PC with the Parallel Interface.

• A Parallel Interface (PI) 500/900 box. (194 441)

• Camera cable 500 (194 450).

• A Power Supply 500/900 unit (194 091).

• An optional Extension cable (194 267).

• The ThermaCAM Researcher CD-ROM (not shown) including PC driver
software.

• A desktop computer with two striped SCSI disk for image storage.

Please read Installing the driver software for the IC2-DIG16 on page 30 as well.
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3.3 System parts Thermovision® 900 Parallel Interface
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Figure 7 Thermovision® 900 parallel interface system parts

• IC2-DIG16 frame grabber (inside the PC) from Imaging Technology Inc. in
USA: A PCI-standardised card with a 44-pin DSUB cable that fits into the side
of the Parallel Interface (PI). A standard RS 232-C cable that connects a
serial port in the PC with the Parallel Interface.

• A Parallel Interface (PI) 500/900 box. (194 441)

• A Power Scanner cable (194 451)

• A Power Scanner 900 box (194 261).

• Two Power Supply 500/900 units (194 091).

• An optional Extension Cable (193 424).

• The ThermaCAM Researcher CD-ROM (not shown) including PC driver
software.

• A desktop computer with two striped SCSI disk for image storage.

Please read Installing the driver software for the IC2-DIG16 on page 30 as well.
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3.4 System parts Thermovision® 1000 Parallel Interface

IC2dig16

RS232
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HDD
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Figure 8 Thermovision® 1000 parallel interface system parts

• IC2-DIG16 frame grabber (in the PC) from Imaging Technology Inc. in
USA: A PCI-standardised card with a 44-pin DSUB cable that fits into the side
of the Parallel Interface (PI). A standard RS 232-C cable that connects a
serial port in the PC with the Parallel Interface.

• A Parallel Interface (PI) 1000 box (194 615).

• A Power Supply 500/ 900 unit (194 091).

• A Thermovision 1000 Power Supply 28 VDC

• The ThermaCAM Researcher CD-ROM (not shown) including PC driver
software.

• A desktop computer with two striped SCSI disk for image storage.

Please read Installing the driver software for the IC2-DIG16 on page 30 as well.
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3.5 The parallel interface (PI)

There are two green LED’s (6) between the RS232 connector (5) and the RS422
connector (7). When power is applied to the parallel interface, the bottom LED will
flash for approximately 15-20 seconds indicating a boot phase. The parallel
interface is ready when the bottom LED stops flashing. If the flashing continues a
boot error has occurred. The top LED will start flashing (camera frame frequency
divided by 8) when it detects an input signal on either Camera 900 or Camera 500
connector. If an input signal is detected on both connectors, then the Camera 900
input has priority.

The Parallel Interface is equipped with a trig input connector (DSUB-9 Male)
which can be configured by modifying jumpers on the interface circuit board. The
trig inputs are not debounced. The easiest way to test the TTL trig input is simply
to ground the TTL input pin, which will create at least one negative flank and a trig
signal.
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Top view of the parallel interface circuit board.

Jumper P8:1 Trig type P8:2 Trig slope P8:3

ON TTL input *) Negative *) Not used

OFF OPTO coupled Positive Not used

*) default setting

Pin description for the TRIG connector

Pin Name Direction Description

1 OPTO+ Input OPTO isolated trig input.
Threshold 0.1 mA at 1.4 V >10 µs duration
1.5 mA at 5V / 15 mA at 24V
Max 24 V cont.
Used together with pin 6.

2 TTL Input TTL trig input.
Threshold 1.2 V >1 µs duration
Max 24 V cont. (12 mA)

3 VSYNC Output TTL synch. output.
Pulse on first image pixel to frame grabber.
0 - 5V max 5 mA.
Pulse width 62.5 ns (THV 500)
or 125 ns (THV 900)

4 EXSYNCB Output TTL buffered synch. signal from
THV 900 scanner.
0 - 5V max 5 mA

5 EXSYNC In/Output Synch. signal to/from THV 900 scanner

6 OPTO- Input OPTO return

7 GND Ground for TTL signals

8 GND Ground for TTL signals

9 RESERVED
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3.6 Software limitations
The frame grabber configuration works on Windows 95 (OS/R1), Windows 98,
Windows NT 4.0 (with service pack 3 or higher) and Windows 2000 operating
systems.

In Windows 95/98/ME, due to file system limitations you cannot get full burst
recording rate for the cameras.

In Windows NT 4/2000, full burst rate recording of the cameras is only available
when the target disk is equipped with a striped NT file system (NTFS).

Images can be stored on PC Card hard disks. Windows NT 4.0 will not allow you
to insert or remove such disks at will. To access them you will have to restart the
computer. Unicore Software Inc. (www.unicore.com) and SystemSoft Corporation
(www.systemsoft.com) have released software packages (CardWare/CardWizard),
which add PC Card hot swapping functionality to Windows NT 4.0. If you intend
to use the PC Card Interface on NT 4, you have to install CardWare 6.00.007 (or
higher) from Unicore.

3.7 PC recommendations
To get a reasonably high performance you should have a Pentium desktop
computer with a clock rate of 200 MHz or more. To achieve burst recording it
should have an internal or external SCSI striped disk set with the NT file system
(NTFS).

The manufacturer of the IC-PCI frame grabber card does not recommend
computers marketed for home use from Packard Bell, Compaq and Acer.

Our recommendation is to set the Colour palette to 256 Colours. True Colour gives
a lower frame rate, but better colour fidelity.
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3.8 Creating stripe sets and formatting NTFS disks in
Windows
This applies to Windows NT 4 / 2000 only.

You must have Administrator privileges to carry out this work.

A stripe set (in Windows 2000 called striped volume) makes two or more physical
disks appear as one single hard disk to the user. Data is written evenly across the
physical disks. The usage of concurrent operations increases the speed of the disk
I/O, and that is very important for burst recordings.

3.8.1 Windows NT 4.0 stripe sets
Note: Information about a stripe set is kept in binary format in the Registry of your
computer. You cannot move the Windows NT 4.0 striped disks to any another
computer and retain the data without moving this information as well. (Very
difficult.)

Partition the Burst disks in Windows NT 4.0:

• Click on Start, Programs, Administrative Tools, and Disk Administrator. If
Windows NT 4.0 asks if you want a disk Signature, click on the Yes button.

• When the disk administrator has started, click on SCSI Disk 1, press the
Ctrl-button and click on SCSI Disk 2. (This will mark both disk 1 and disk 2.
Make sure that no other disks are marked!) Open the Partition menu and
select Create Stripe Set.

• On the Create Stripe Set dialogue, click on the OK button. Open the menu
again and select Commit Changes Now... On the Confirm dialogue, click on
the Yes button and press Yes again when asked to restart the computer.

Format the Burst disks in Windows NT 4.0:

Start the Disk Administrator again and click on SCSI disk 1 (both disk 1 and disk 2
should now be highlighted). Open the Tools menu, select Format... On the
dialogue change the File System selection to NTFS, mark Quick Format and click
on the Start button. On the Format dialogue, click on the OK button. When the
disks are formatted, select Close. Leave the Disk Administrator.
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3.8.2 Windows 2000 striped volumes

Creating and formatting striped volumes in Windows 2000:

• Click on Start, Settings, Control Panel. Double-click on the Administrative
Tools and Computer Management icons.

• When the Computer Management window has started, click on Storage and
Disk Management in the left view. The two SCSI disks will now appear as
basic disks, each one with a separate drive letter and a separate number,
normally Disk 1 and Disk 2. If other numbers appear, please use them
instead in the description below.

• Click with the right mouse button on the text “Basic” below the text
“Disk 1”. Select Upgrade to dynamic disk from the menu. Mark the proper
two SCSI disks in the dialogue that appears. Click OK.

• From the same menu for Disk 1, select Create Volume. If the entry isn’t
active, you may have to select Delete Volume first.

• Press Next to skip the Welcome dialogue. In the next dialogue that appears,
select Striped Volume as the volume type. Press Next.

• Select the other SCSI disk and press Add. Press Next.

• Assign a drive letter to the striped volume. Press Next.

• Select the NTFS file system for the new volume. Press Next.

• Check that the information on the last dialogue is correct. Press Finish. The
formatting of the new volume will now begin.

Importing striped volumes in Windows 2000:

• To import a volume, striped on one Windows 2000 computer into another
Windows 2000 computer, click on Start, Settings, and Control Panel.
Double-click on the Administrative Tools and Computer Management icons.

• When the Computer Management window has started, click on Storage and
Disk Management in the left view. The two SCSI disks will now appear as
foreign disks, each one with a separate number, normally Disk 1 and Disk 2.
If other numbers appear, please use them instead.

• Click with the right mouse button on the text “Foreign” below the text
“Disk 1”. Select Import foreign disks from the menu. Mark the right two
SCSI disks in the dialogue that appears. Click OK.

• On the next dialogue, select an appropriate drive letter and click OK.
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3.9 Installing the driver software for the IC2-DIG16
Note: When you start to use the IC2-DIG16 card, after having installed these
drivers, it may happen that the computer does reprogram the prom of the IC2-
DIG16 card and order you to restart the computer immediately. That is part of the
normal installation routine for this card, and nothing to worry about, unless it
happens more than once. You will have to be logged in as Administrator in NT for
this reprogramming to be possible.

3.9.1 Windows NT 4.0
Insert the IC2-DIG16 frame grabber into a free PCI bus slot.

Please log in as Administrator during this installation.

Insert the ThermaCAM Researcher CD-ROM into your CD drive. The CD-ROM
will show a window of its own from which you can select to install Windows NT
drivers. Start that installation utility and select "Frame grabber" drivers.

The installation utility will copy some files and update the Windows Registry.

3.9.2 Windows 95/98/ME/2000
Insert the IC2-DIG16 into a free PCI bus slot. Windows 95/98/ME/2000 will
detect the new hardware and display a New Hardware Found message (or
Multimedia Video Controller Found ) together with a Wizard dialogue. Insert the
ThermaCAM Researcher CD-ROM into your CD drive. The CD-ROM will show a
window of its own, but just remove that by clicking Exit. If you have Windows 95
version A then select the alternative Driver from disk provided by hardware
manufacturer, otherwise follow the wizard guide.
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3.10 Troubleshooting the frame grabber installation
Problems with the frame grabber and its installation don’t always show up
immediately. You might not notice them until you try to get a live image from the
camera.

Our experience is that hardware installations do not always run smoothly. A
number of detailed suggestions on how to overcome known difficulties are
available in an “InstHints” document on the ThermaCAM Researcher CD-ROM.

To work properly, the frame grabber configuration needs:

• A correct “Type of camera” and “Type of connection” setting in the Select
Camera dialogue.

• A standard serial port.

• Appropriate BIOS settings.

• Software for the device drivers on Windows NT/2000.

• A functional IC2-DIG16 frame grabber.

• A successful installation of ThermaCAM Researcher.

• A number of fix computer memory slots.

• An interrupt request (IRQ) of the right (PCI) type

• A Parallel Interface to convert the camera output.

• Reliable cables and electrical connections.

• A camera equipped for digital output.

The most frequent problem with the frame grabber installation are no doubt plain
cabling connection difficulties.
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This fairly simple troubleshooting scheme may help you locate your problem:

• If you get a message in the system event log on Windows NT 4 from the
mvcntp device (= the frame grabber) or a warning symbol for the Imaging
Device in the Device Manager on Windows 2000, then the BIOS settings for
the frame grabber resources aren’t OK. Check the interrupt types and make
sure that the BIOS PnP OS flag is set to NO. Moving the frame grabber to
another PCI slot might also help.

• If ThermaCAM Researcher says Disconnected, there is something wrong with
the selected serial port or its settings. The serial port may also be occupied by
another instance of ThermaCAM Researcher.

• ThermaCAM Reserarcher does try to establish a connection with the camera
using the serial communication port before trying to capture any images.
If you get the Connecting… status text without any reply from the camera,
there could be cabelling problems or, simply, the wrong type of camera or
connection type.

• If you get a serial connection to the camera (ThermaCAM Researcher says
“Connected”) but no image, there might be some problem with the camera
(such as insufficient cooling or hardware) or problems with the image flow
(i.e. cabelling problems) or the wrong type of interrupt for the frame grabber
or a computer memory window resource conflict. Other PCI cards in the
computer might be interfering with the frame grabber.

For more information on how to deal with these matters, please check the InstHints
document on the ThermaCAM Researcher CD-ROM.
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4. Application software installation

4.1 Installing ThermaCAM Researcher
ThermaCAM Researcher is designed to run on Windows 95/98, Windows
NT 4, with service pack 3 or higher, Windows 2000, or Windows Millennium.

When you insert the ThermaCAM Researcher CD-ROM into your computer, a
window will appear, from which you can start the installation of the application
and of the NT 4.0 drivers.

(You may already have installed the NT 4.0 or Windows 95/98/2000/ME drivers,
else see Installing the driver software for the PC Card interface on page 16 or
Installing the driver software for the IC2-DIG16 on page 30.)

If you have Windows NT 4.0 or Windows 2000, log in as Administrator during
the installation.

Click on ThermaCAM Researcher to start the installation. It is made by a utility
program, which will guide you through the installation steps, and do most of the
work for you. If you are asked to restart Windows, please do that before continuing
with the installation.

During the installation of ThermaCAM Researcher, you will be asked to type in
your license number. The license number is unique, and can be found on the first
page of the manual.

The directory structure of ThermaCAM Researcher is pre-set. The only adaptation
you can make during the installation is to change the name of the directory in
which the program is installed.

After the installation, you will be able to start ThermaCAM Researcher from the
Programs entry of the Start button menu. Until you have installed the PC Card
Interface or the frame grabber and their drivers, you will however not be able to
connect to the camera, only to work with disk images.
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4.2 Where do the installed files go?
On all Windows systems, the installation program builds a new directory tree,
normally at C:\Program Files\ThermaCAM Researcher XXXX, containing the
following files:

Researcher XXXX\ Executable files, help file, OLE type library.

…\Examples Sample Excel files with their session files.

…\Images Sample Image files

…\Palettes Palette files (scale colour definitions).

The installation also adds some executable files into the main Windows directories.

On Windows 2000, which is a multi user system, only administrator users may
create and update files in the common Program Files directory. Ordinary users are
not permitted to do that. Ordinary users have a place of their own where they can
keep the data files of their programs. It is called “My Documents”.

On Windows 2000, the \Examples, \Images and \Palettes files are copied to a
ThermaCAM Researcher XXX subdirectory of the “My Documents” directory of
each user when he, or she, starts to use the software. Then each user easily can
modify them separately.

(These “My Document” files are not removed by an un-installation.)
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5. About Thermography

5.1 Introduction to Thermography
The infrared camera measures and images the emitted infrared radiation from an
object. The fact that radiation is a function of object surface temperature makes it
possible for the camera to calculate and display this temperature.

However, the radiation measured by the camera does not only depend on the object
temperature but is also a function of its emissivity. And, radiation that originates
from the surroundings becomes reflected in the object. Moreover, radiation from
the object and the reflected ambient radiation are influenced by the absorption in
the atmosphere and in any external optics it passes through.

To measure temperature accurately, it is therefore necessary to compensate for the
effects of a number of different radiation sources. The following object parameters
must be supplied:

• Emissivity
• Ambient temperature
• Atmospheric temperature

• Distance
• Relative humidity of the air
• External optics transmission and temperature

5.2 Emissivity
The most important object parameter to set correctly is the emissivity, which, in
short, is a measure of how much radiation is emitted from the object compared to
that if it were a perfect blackbody.

Normally, object materials and surface treatments exhibit emissivities ranging from
approximately 0.1 to 0.95. A highly polished (reflective) surface falls below 0.1,
while an oxidised or painted surface has much higher emissivity. Oil-based paint,
regardless of colour in the visible spectrum, has an emissivity over 0.9 in the
infrared. Human skin exhibits an emissivity close to 1. Non-oxidised metals
represent an extreme case of almost perfect opacity and high specular reflectivity,
which does not vary greatly with wavelength. Consequently, the emissivity of
metals is low - only increasing with temperature. For non-metals, emissivity tends
to be high, and decreases with temperature.

Typical emissivities for a variety of common materials are listed in the table below.
The values are meant to be used only as a guide and can vary depending on many
different factors.
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Metals and their
oxides  

Temp°C Emissivity

Aluminium: foil (bright) 20 0.04

weathered 20 0.83 - 0.94

Copper: polished 100 0.05

heavily oxidised 20 0.78

Iron: cast, oxidised 100 0.64

sheet, heavily rusted 20 0.69 - 0.96

Nickel: electroplated, polished 20 0.05

Stainless steel
(type 18-8):

polished 20 0.16

oxidised 60 0.85

Steel: polished 100 0.07

oxidised 200 0.79

Other materials Temp°C Emissivity

Brick: common red 20 0.93

Carbon candle
soot:

20 0.93

Concrete: dry 35 0.95

Glass: chemical ware 35 0.97

Oil: lubricating 17 0.87

film thickness 0.03 mm 20 0.27

film thickness 0.13 mm 20 0.72

thick coating 20 0.82

Paint: oil, average of 16 colours 20 0.94

Paper: white 20 0.07 - 0.90

Plaster: 20 0.86 - 0.90

Rubber: black 20 0.95
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Skin: human 32 0.98

Soil: dry 20 0.92

saturated with water 20 0.95

Water: distilled 20 0.96

frost crystals -10 0.98

snow -10 0.85

Wood: planed oak 20 0.90

5.3 Finding the emissivity of an object
We need to know the emissivity of an object in order to be able to calculate its
temperature. If, on the other hand we know the temperature of the object, and it is
far above or below the ambient temperature, then the emissivity can be calculated
from the shown (faulty) value of, for instance, a measurement area.

One way to measure the temperature is to use a thermocouple.

Another way is to put a piece of tape or paint of a known emissivity onto the object
and make the camera measure the temperature in that way.

Use the emissivity calculation function of ThermaCAM Researcher to calculate
and apply the new emissivity, see Emissivity calculation on page 91.

5.4 Ambient temperature
This parameter is used to compensate for the radiation reflected in the object.

In some cameras, it is also called Background temperature.

If the emissivity is low and the object temperature relatively close to that of the
ambient it will be very important to set and compensate for the ambient
temperature correctly.

5.5 Atmospheric temperature, humidity and distance
These parameters are used to correct for the fact that radiation is being absorbed in
the atmosphere between the object and the camera and the fact that transmittance
drops with distance.
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If the humidity of the air is high, the distance very long and the object temperature
relatively close to that of the atmosphere it will be important to set and compensate
for the atmosphere correctly.

The distance is the distance between the object and the front lens of the camera.

The transmittance is heavily dependent on the relative humidity of the air. To
compensate for this, set the relative humidity to the correct value. For short
distances of air with normal humidity, the relative humidity can usually be left at a
default value of 50 %.

If you have a better estimate of the properties of the atmosphere than the built-in
model has, you can enter your estimated transmission value instead.

To avoid applying this type of compensation, please set the estimated transmission
to 1.0.

5.6 External optics transmission and temperature
Sometimes, the radiation from the object also has to pass through some optical
accessory, such as a heat shield or a macro lens, before reaching the camera. Then
that optics, external to the camera, will absorb some of the radiation. To correct for
this effect, enter the transmittance and temperature of the optics.

Ambient reflections in the external optics are not taken into consideration
mathematically, so the optics either has to have a non-reflective coating or have the
same temperature as the ambient (on the camera side) to make the correction work
properly.

Please avoid ambient reflections. Do, for instance, make sure that the camera
cannot see itself mirrored in the external optics.

To avoid applying this type of compensation, please set the external optics
transmission to 1.0.

5.7 Infrared spectral filters
Any object, with a temperature above 0 Kelvin, will emit electromagnetic radiation
over a wide spectrum. The hotter the object, the stronger and wider the radiation,
and the shorter its wavelength. Infrared detectors are only sensitive in parts of the
infrared waveband. This means that the temperature calculations in infrared
cameras make assumptions about the amount of radiation present in other
wavebands.

Infrared cameras are calibrated with a set of standard blackbodies at various
temperatures. Any object in air, behaving like a blackbody, can thus be treated
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properly by the camera. Sometimes, there are different conditions. Hot gases, for
instance, emit radiation only at discrete wavelengths, “stripes”. Cold gases absorb
radiation in stripes. To be able to make accurate measurements under such
circumstances, you have to use the right spectral filters.

5.8 Units of measure
Thermography really means making images of thermal surface property variations
of objects. The most natural property to measure is of course temperature, which
has the units Celsius, Fahrenheit and Kelvin in ThermaCAM Researcher.

Another interesting property is the total amount of radiation emitted from the
object but, since the infrared camera is sensitive only to parts of the spectrum, no
accurate such measurement can be made. Hence no standardised unit is available
for radiation display. Instead, the non-calibrated unit “Object Signal” (abbreviated
OS) has been invented. Being approximately proportional to the amount of
radiation sensed by the camera detector, it can be used for comparative radiation
measurements within the same measurement range for the same camera. If you
intend to use it in some other way, you have to provide a calibration of your own.

Some measurements, such as the standard deviation, produce a result which best
could be described as a “Difference Temperature” (or “Difference Object Signal”).
They involve a subtraction, which cancels out the existing absolute level. A
standard deviation of 2.5 at 25 °C is the same thing as a standard deviation of 2.5 at
50 °C. In such cases, the units DeltaCelsius (dC), DeltaFahrenheit (dF),
DeltaKelvin (dK) and DeltaObjectSignal (dOS) apply.
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6. About the program

6.1 Basic principles for ThermaCAM Researcher
The main purpose of this program is to deal with live IR images arriving through a
Camera interface. It can also receive IR images from other media, such as PC Card
hard disks from ThermaCAM cameras.

The program can make studies on high/medium/slow speed thermal events
depending on the hardware configuration. It can show IR images, record them on
disk and analyse them afterwards during their replay. It can provide measurement
result values directly from the live stream of images too, but only for the images
you decide not to record.

The measurements are made with the following analysis tools: isotherm, spotmeter,
area and line. The results produced by these tools can be displayed within the IR
image, in the profile window, in the histogram window, in the result table window,
or in the plot window. Formulas can be applied to the results.

The program uses a set of predefined screen layouts, one for each type of work that
you could have in mind.

You can also extract information from ThermaCAM Researcher by using OLE
(which is an automatic way of transferring information between programs running
under MS Windows) to bring the information into for example Excel or Word. The
IR image can be transferred in the same way.

Images can also be transferred to ThermaCAM Reporter for analysis and report
generation. The clipboard functions copy and paste are used for this purpose.

Several copies of ThermaCAM Researcher can run at the same time, but only one
at a time can be connected to the camera interface.

6.2 Working with ThermaCAM Researcher
A typical user of the PC Card Interface configuration of ThermaCAM Researcher
would probably install it both on a laptop computer, which easily can be brought
along to the site where the data is to be collected, and on a stationary computer
connected to a network with printers and disks on it.

A typical user of the Parallel Interface configuration of ThermaCAM Researcher
would install it on a fast desktop computer, which permanently is located at the site
of some important experiment. The Parallel interface cannot be installed on a
laptop.
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At the site, the user would set up the camera, connect it to the computer and start
recording.

Some users will record images, lots of images, and go back home in order to study
them. Others will immediately make measurements and simply record a few values
on paper or in a spreadsheet and forget about the images on which they are based.
Some users are satisfied with the temperature measurements as such, others want
mathematical functions of temperature or to correlate the measurements to
something else, like pressure or vibration or the incidence of some event.

Being careful when setting up the camera will normally improve the measurement
results. This could mean measuring the object parameters carefully, avoiding
creating images containing reflections from strong heat (or cold) sources in the
neighbourhood, using a spectral IR-filter which is appropriate for the application
and so on.

Before studying the recorded images, one has to pick out and examine the really
interesting ones. Then one normally finds that something has to be done to them
before the actual analysis begins. The emissivity factor might be wrong, or the
temperature scale limits or the analysis tool is missing or whatever. (The images
recorded by ThermaCAM Researcher do not contain any analysis; it has to be
added on.)

In this preparatory step, the user will scan through all the images, noting the
interesting ones, grouping them and preparing them for analysis. This involves
either applying a correction to each individual image, actually changing the file, or
using a standard correction replacing some parameter of the images but not
changing the images themselves.

The standard correction is, in this program, often indicated by the word “lock”. It is
possible to lock the temperature scale, lock the object parameters the analysis
functions and lock the zoom factor. This means for instance that you can apply
your favourite temperature scale to an image by locking the scale and setting it to
your favourite values. The current image, and the ones that follow, will be
presented with your favourite scale despite having another scale stored inside
them. When you unlock the scale, the original scale of the image will reappear.

The actual analysis involves playing through the images once more, taking values
from the analysis tools of the images and comparing them to what was expected.

The analysis might be preceded by a conversion of some kind, such as image
subtraction.

The results of the study might become an important part of a research report, a
graph or a set of images supporting some vital conclusion.
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6.3 The list of current image files
When you store images with ThermaCAM Researcher you can either store them
one by one, giving each image a characteristic file name, or store them as a
sequence thus indicating that they have something in common.

Such a sequence of IR images is recorded in an image directory either as separate
files or in a single file. This is a decision you take when you set the recording
parameters.

When the recording is finished, the sequence recording function assumes that you
would like to replay and analyse the new images. It creates a list of the image files
concerned and keeps it until the next recording.

This list, a group of names of image files in the same directory, is what still keeps
the sequence together. You may change the list at will, adding or removing file
names, but then the sequence concept is lost.

You can actually group any images you like into a fake sequence. The only
restriction is that they have to be stored in the same directory on the disk. You do
not have to include all the images of the directory.

Single file image recordings are normally quite large. ThermaCAM Researcher has
functions that will let you edit these files. Then you are supposed to first open all
images and then mark the images to be removed or copied as a selection.

6.4 The image directory
All the images of the same recording are placed in the same directory on disk. We
call it the image directory. The full path name of the image directory is displayed
in the program title bar. You should set it when you determine the conditions for
image recording (or when you create a new image list out of pre-recorded images).

6.5 Session files
You often need to be able to recreate particular situations (such as an experiment)
during your work. ThermaCAM Researcher uses session files for this purpose. It
stores for example the names of the currently open images in its session files. They
do however not contain the images themselves. (You will notice this, if you save
your session while looking at a frozen live image. When the session is recreated,
the former live image is gone.)

The full path name of the image directory is also stored in the session file.
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If you move the images (or try to reach them from another computer in which the
image directory has another path), you will have to correct this path in order to be
able to see the images again.

Normally, every recording of images would be ended with the creation of a session
file. It would usually be placed in the same directory as the images, but that is not a
requirement. Later, when you start analysing the images, you pick up the session
file, add analysis tools or other settings to it and save it to disk again. The session
files do not contain any images or analysis results, only file names and information
about the program settings.

You may select a session file to become the default session. This means that every
time you start ThermaCAM Researcher or order a brand new session, the default
session settings and images will be fetched. The Set Default Session command is in
the File Menu.

Should you wish to avoid reading the default session, please press the keyboard
shift button while ThermaCAM Researcher starts.

You deselect the default session by opening the default settings dialog and pressing
the Cancel button.



 ThermaCAM Researcher 2001 Operating Manual

44

6.6 Program screen layout

There are several layout options available. These are controlled by tabs in the
bottom part of the ThermaCAM Researcher window. You can see combinations of
the IR image, the profile, the histogram, the plot and the result table windows. All
tabs have an IR image with a temperature scale in the top left corner.

You cannot reposition the windows within the tabs, but you can catch and move
the splitter bars that separate the windows, thus increasing or diminishing the
relative size of each of the windows.

You can copy the whole program window to the clipboard by pressing the Alt +
PrintScrn key buttons. You can also save the current tab as a bitmap by the
command "Save Tab As" in the File Menu

The program can only show one image at a time. On the image, the analysis tools
are displayed. The results of the analysis tools can be displayed in the histogram,
profile, plot or result table window.
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The main layout of the program is pretty much like any other Windows program.
On the top line of the program window, there is a title containing a session name,
the image directory and the three buttons, minimise, maximise and close, from left
to right. The same functions are available on the right mouse button menu of the
top line.

Below the top line, there is a set of drop-down menus by which you can select
functions related to session/image filing (File), the Clipboard (Edit), the screen
layout (View), the camera (Camera), the display and analysis of the image (Image)
and the recording/playback of images (Recording).

There is also a large number of toolbar buttons. There are tool buttons for almost
every function of the program. Every tool button has a short yellow description that
will pop up if you hold the mouse cursor still for a while on top of it.

The tool bars are normally docked to the borders of the program window, but can
be undocked and placed anywhere on the screen. Just double-click on them.

There is also a floating camera control panel that can not be docked to the program
window. Use it to change the camera measurement range and affect how the live
image is generated.

At the bottom of the program window, on the status line, a more detailed
description of the menu items and tool bar buttons will be shown while you sweep
through menus and over the tool buttons by the mouse cursor. Towards the right of
this status line, there are indicators of the Interface status and the Camera status as
well as keyboard indicators for Caps Lock and Num Lock. You can click on the
Interface and Camera indicators and get further information about the interface and
the camera.

The following buttons exist on the standard tool bar:

• Create a new session.

• Open an existing session.

• Open/Add images to the current session.

• Save the current session using the current name.

• Copy the session file and the current image to the Clipboard

• Copy values, such as analysis results, as text to the Clipboard.
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• Paste a copied session into ThermaCAM Researcher. The name of the session
is not pasted.

• Print the current image.

• Select disk images as the image source.

• Select the live camera as the image source. This button is “down” indicating
that a camera image is being shown.

• Move the camera focus towards infinity.

• Move the camera focus towards the lens.

• Switch on the function Automatic adjustment of the image scale.

• Freeze the live stream of images from the camera.

• Bring up the image settings dialogue window.

• Bring up the palette selection dialogue.

• Bring help from the manual.

The following functions exist on the play images tool bar:

Top row:

• Show second row: on/off.

• Name of the current image. (You may type a name or number in this field.)

• 7 VCR style playback buttons. Stop in the middle.

• A control by which the replay rate is controlled.
”*1” means full speed from disk.
“*2” means twice full disk speed (i.e. every other image is not shown) and
“÷2” means half full speed.

• Auto rewind button.
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• The “lock temperature scale” button.

• The “lock object parameters” button.

• The “lock analysis tools” button.

• The “lock zoom factor” button.

The “lock” buttons will, when pressed down, let you keep the same temperature
scale / object parameters / analysis tools / zoom factor for all images being
replayed, regardless of what is stored inside the images. When you “lift” these
buttons, the information of the images will be used instead.

Second row:

• Current image time/frame/trig count.

• First image time/frame/trig count.

• Slider. Move fast within your image sequence. The first image is to the left.

• Last image time/frame/trig count.

The time/frame/trig count field depends on the Presentation selection in Replay
Settings in the Recording menu. It is either absolute image time, relative time to
first frame, frame number or trig count.

• Set selection start.

• Set selection end.

"Start" is always to the left of "end". The slider will highlight the selected area
within the sequence with a blue colour.

 The following functions exist on the recording tool bar:

 

• Name of the next image to be recorded.

• Start button.

• Start condition field.

• Record one image button.

• Recording condition field.

• Pause button.

• Stop button.
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• Stop recording condition field.

• Bring up the recording conditions dialogue window.

• Replay the recorded sequence in a separate copy of ThermaCAM Researcher.

The following functions exist on the image directory tool bar:

• The image directory. (You may edit this field to change it.)

• Browse existing directories.

The following analysis tools exist:

• Spot meter.

• Flying spot meter. (Uses the mouse cursor.)

• Line, with cursor.

• Box area.

• Circle area.

• Polygon area.

• Isotherm (above, below, interval).

• Formulas

• Removal tool.

The following functions exist on the scaling tool bar:

• Scale max temperature field. Editable.

• Scale min temperature field. Editable.

• Current measurement unit indicator.

• Slider for the scale max and min temperature. Drag with mouse. Min is to the
left.

• Automatic adjustment of the scale to the image: on/off.
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• Lock span: on/off. (Changes apply only to the level.)

The highlighted region in the sliders indicates the span of temperatures in the
image. By selecting Auto Adjust, you will place the slider markers close to the
ends of the highlighted area, but still inside it. A small part of the span is thus
“wasted”.

6.7 Shortcut keys
Menu selections can be made from the keyboard. Press Alt + the key indicated on
the menu line by an underscore. This brings up the menu. Then press the key
indicated in the menu by an underscore to select that item.

In addition to the tool bars, there are a number of shortcut keys on the keyboard by
which important functions can be reached:

Ctrl + A Auto adjust image

Ctrl + C Copy session and image

Ctrl + D Play recorded sequence

Ctrl + F Freeze/Unfreeze image

Ctrl + I Open disk images

Ctrl + L Show live images

Ctrl + N New session

Ctrl + O Open session

Ctrl + P Print

Ctrl + V Paste session

Ctrl + S Save session

Ctrl + R Autorewind mode on/off

Ctrl + T Show the camera control

Ctrl + Tab Next main tab

Ctrl + Shift + Tab Previous main tab

Home First disk image

End Last disk image

F2 Play backwards
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F3 Stop playing

F4 Play forwards

Ctrl + F2 Step backwards

Ctrl + F4 Step forwards

Shift + F2 Fast backwards

Shift + F3 Stop

Shift + F4 Fast forwards

Ctrl + Shift + F4 Set selection end (within sequence)

Ctrl + Shift + F2 Set selection start (within sequence)

Page up/down Changes min scale temperature

Ctrl + Page up/down Changes max scale temperature

F5 Image recording keyboard trig

F8 Freeze/Unfreeze image

F11,F12 Camera focus

Alt + F4 Exit

(All shortcuts do not work in OLE embedded mode.)
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7. How to....

7.1 How to begin using a camera
We recommend that you connect the cables, insert the PC Card Interface or power
up the parallel interface and start the camera before starting the ThermaCAM
Researcher program. The computer may play a little tune, often a double beep,
when the PC Card is inserted or removed.

The first time you run ThermaCAM Researcher, you will have to indicate which
type of camera you have got and how it is connected physically. This dialogue
automatically shows up:

You do have to bring up this dialogue yourself (from the Camera menu), if you
want to change the selected camera type or connection.

When you are using the ICPCI frame grabber, you must indicate to which serial
port the cable from the parallel interface box is connected.

When you are using the Parallel Interface, you have the option of specifying the
serial port or letting ThermaCAM Researcher find it for you (recommended).
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7.2 How to connect and control the camera
In order to be able to show a live image, ThermaCAM Researcher has to establish
a software connection to the camera. The status information of the Camera Control
panel will reveal if the program is trying to connect to the camera or not. If it says
Disconnected, you will have to order a new connection by selecting Connect from
the Camera menu.

If ThermaCAM Researcher is showing a disk image, you will have to select Show
Camera Image from the Camera menu or press Ctrl + L or push this tool button to
make the program consider connecting to the camera and displaying its image.

The purpose of doing these soft connections/disconnections is that it enables you to
run two or more copies of ThermaCAM Researcher. You can disconnect the
camera from one copy and connect it to another instead.

After the connection is established, it may still take some time before the logo
image disappears. The camera has to run for a while, before its detector is cool
enough to produce a live image.

The first time a SC 1000 camera is connected, a large calibration file will be
unloaded from the camera, before a live image can be shown.

If you get into connection difficulties here, see About connection difficulties on
page 59 for more information.

Note: Do not remove the PC Card or switch off the camera while ThermaCAM
Researcher is running unless you have selected Disconnect from the Camera menu
first.

The Camera Information dialogue and the Camera Control panel are the two main
ways by which you communicate with the camera.

Take a quick look at the Camera Information dialogue, which can be reached from
the Camera menu or by clicking on the Camera symbol to the right on the status
line below the image. It will probably show the name of the camera and that it is
working. Otherwise the reason of failure is displayed here (or in the Device Status
panel displayed if you click on the Interface symbol to the lower right of the
program window).

Let’s OK the Information dialogue and take a quick look at the Camera Control
panel. We will study it in more detail in the next sub-chapters.
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Let’s examine the Measurement Range list. Select a range, which covers the
expected measurement temperatures. The range limits are blackbody temperatures,
so if your measurement target has a shiny surface with a low emissivity, you will
be able to make measurements above the range limits.

An image, which is probably blurred, is shown on the screen. Otherwise, press the
candle tool button to get a better scale in the PC. Some cameras have their own
ways of adjusting the image and improving its quality. See the appropriate camera
control description below.

Aim the camera onto the target. Time to focus the camera! You can either use the
focus buttons on the Camera Control panel or the two buttons below (found on the
Standard Toolbar). You also have the option to use the F11/F12 keys.

Hold down the button in order to run the focus motor of the camera towards
infinity or towards the lens. Release the button when the focus is OK, or rather
slightly before. There is a small delay before the focus motor stops.

If you are satisfied with your image, you can freeze it by pushing this button on the
standard tool bar or pressing Ctrl + F or F8:

If it is an interesting image, you had better save it on disk right now. If you leave
the program without first recording the image, the image is lost. See How to record
IR images on page 64.
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7.2.1 The THV 500 Camera Control
This control panel is used for ThermaCAM SC 500, ThermaCAM SC 2000,
ThermaCAM SC 3000 and similar camera models.

       

If some button is disabled on your camera control, it is because your particular
camera does not support that function.

The selected Measurement Range should cover the expected measurement
temperatures. The range limits are blackbody temperatures, so if your measurement
target has a shiny surface with a low emissivity, you will be able to make
measurements above the range limits.

The “Image Speed” control allows you to increase the speed by which images are
captured in a high-speed camera. The speed by which they are grabbed by the PC
frame grabber remains unchanged, however. This has the effect that the high-speed
image size is reduced proportionally, so that each frame will contain more than one
image. Only under one condition, when you record images at full speed into one
single file, will you be able to retrieve all the captured high-speed images. In all
other cases, you will only see the first image of each grab.

If you press the Int(ernal) Image Correction button on the Camera Control panel,
the camera will respond by making a rather heavy clicking sound when the internal
shutter is pulled and adjust its own temperature scale once to the current image. It
is highly recommended to use the Int. Image Correction function now and then,
since it improves the image quality. Check the Auto shutter checkbox if you want
an automatic internal image correction.



ThermaCAM Researcher 2001 Operating Manual

55

Note: There is a related function in the Image menu, on the standard tool bar and
on the scaling tool bar. That function is called Auto Adjust. It is “sticky” and will
continuously adjust the scale to the image locally, within the PC.

If you try to study targets whose temperatures are close to or even outside the
measurement range, it might happen that the image becomes noisy due to detector
offset errors. That is when you should use the External Image Correction function.
There is a button on the camera control panel and a camera menu item for this
purpose. Aim the camera towards a surface with a flat temperature close to that of
the target. Push the button. The image will now be subjected to an offset correction
so that every part of the image will get the same value as that in the middle. Aim
the camera towards the target again. This correction will last until the next time
you internally correct the camera image, or run External Image Correction again.

At the bottom of the first tab, there are three focus buttons. Near focus (-), auto
focus (=) and far focus (+).

Let’s move over to the second tab on the Camera Control panel.

High noise reduction will blur the image of moving objects.

To improve image quality, you can check the Slow motion objects check box if
you are viewing slowly moving or still targets.

The Cooler button will switch on/off the camera cooler.

The Auto shutter check box will switch on/off the automated internal image
correction. This automated process can be disabled as it may affect the recording of
images. When you switch it off, a warning will appear on the status field of the
control. This warning will become red if you leave it switched off for a long time.
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7.2.2 The SC 1000 Camera Control
This control panel is used for ThermaCAM SC 1000 only.

Select a Measurement Range that covers the expected measurement temperatures.

If you press the Auto Span  button on the Camera Control panel, the camera will
adjust its own temperature scale once to the current image.

The focus function will only work if the focus motor switch by the lens socket is in
the R position.

The SC 10000 camera also has a Non-Uniformity Correction (NUC) function,
available only through its Set-up menus, that you can use to improve the image
quality.

The SC 1000 has a calibration file, which will be unloaded from the camera, when
it is connected for the first time. If you have the camera sent in for recalibration,
you have to initiate the unloading of this file again, from the "Info" tab.
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7.2.3 The THV 900 Camera Control
This control panel is used for Thermovision 900 Cameras.

There is a Cassette selection, which must be set to the number of the cassette
actually installed in the camera, a Filter selection, which reflects the IR filters of
that cassette, and a Measurement Range selection. The Measurement Range
selection is tightly coupled to the two others. If you change them, the measurement
ranges will change accordingly.

The range should cover the expected measurement temperatures. The range limits
are blackbody temperatures, so if your measurement target has a shiny surface with
a low emissivity, you will be able to make measurements above the range limits.

Ideally you should make your proper Cassette/Filter/Range selections immediately,
but it is often easier to select a measurement range, which is well suited to the
surroundings first and then set the proper range afterwards. It makes it easier for
you to focus the camera.

The “Motor power” switches control the camera horizontal and vertical scanning
mirror motors. On stirling cooled cameras you may also put the cooler in standby.

You can set the frame rate to 30 Hz by selecting the high frame rate option. The
number of lines will decrease when the frame rate is high. The scanner use the high
frame rate as long as the power is on, or until you select normal frame rate again.
After a power on, the frame rate is always normal.
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7.2.4 The THV 1000 Camera Control
This control panel is used for Thermovision 1000 cameras only.

Let us investigate some of the alternatives in the Camera Control panel.

Camera image correction performs an internal
Auto adjust.

Lens changes the camera field of view.

Camera averaging selects the level of noise
reduction. Heavy averaging will reduce the
noise for still or slow moving objects but will
blur fast moving targets.

Camera palette selects the camera palette used
for the camera video output. Don’t confuse this
control with the image palette option in the
Image menu.

Line corr(ection). Correct each image for
geometric detector differences. This will give
you a better image quality but will decrease the
image display rate.

Focus calibration: The focus has a tendency to
drift as the temperature of the lens varies. Use
this function to set the correct focus infinity
position.

Time averaging. In order to reduce noise set
the number of images to average from and then
press Record One Image. You can’t combine
time averaging with sequence file recording.
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14 bit resolution. Save time averaged images with 14 bits per pixels. To
interpret the image correctly, you need special software.

Standby. Set the camera cooler and motors in standby mode. Press the button
again to restart the camera.

7.2.5 About connection difficulties
At times, you may run into difficulties establishing a connection with the camera.
Here are some suggestions on what you can do:

The program is having problems with the camera. It only works now and
then.

Take care in inserting your PC Card Interface properly into the PC Card Adapter.
Make sure that the card has been recognised and properly configured (is indicated
with a little tune) before you start ThermaCAM Researcher. The same caution is
required when the Interface is to be removed or switched off. Always exit the
program or select Disconnect from the camera menu before you pull the Interface
out or switch the power off.

The program refuses to establish a contact with the camera. The status
information keeps saying Disconnected while the camera is running.

The camera may be connected to another copy of ThermaCAM Researcher. Switch
over to that one and disconnect the connection. Now the new ThermaCAM
Researcher can connect to the camera.

The status information says Connected, but no live image is shown.

If you are using a ThermaCAM SC 1000, please check that no “Maintenance
Required” information is displayed in the camera viewfinder. If you accidentally
have put the SC 1000 in Setup-mode, it can also cause this problem.

Further information.

Your problems may be related to the hardware installation. Please read more about
it in Troubleshooting the frame grabber installation on page 31 or Troubleshooting
the PC Card installation on page 19.
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7.3 How to display an IR image

7.3.1 Obtaining a good IR image
In order to get a good image from the camera, you should establish a connection,
select an appropriate measurement range, auto adjust it, and focus it as described in
the previous chapters.

No matter if you have a live image, a frozen image or a disk image, you should
now consider the object parameters (emissivity, ambient temperature, atmospheric
temperature, relative humidity of the air, the distance and the external optics
transmission and temperature). They describe the physical properties of the body of
interest and its environment and the atmosphere between the object and the
camera. You can reach them via Settings in the Image menu or this button:

It is important that these parameter values become correct. Otherwise the scale
temperatures and displayed colours will be wrong. The image parts for which the
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object parameters are wrong will get incorrect temperatures and colours. (The
measurement functions have object parameters of their own which are used to
handle the case when there are two different targets in the same image.)

To calculate the emissivity of an object, see Emissivity calculation on page 91.

If the colours of the image are inappropriate, you can change them. The selection
Palette tool button will bring up a dialogue window with the palettes available.

Contrary to what you might think, the Show saturation colours option enables
specific colouring of image points, which are outside the current temperature scale.
The Show out of range colours option enables specific colouring of image points,
which are outside the detectable range of the camera.

You can change the temperature scale with this control bar:

You can use the slider to search for a good scale or to set fixed limits. Remember
that the maximum temperature always has to exceed the minimum temperature.
Click on the input fields if you want to edit them and hit the Enter key afterwards.
If you select Auto Adjust, you will find that an attempt to find the optimum scale is
made for each new image. A small part of the temperature span of the image is
however wasted, to minimise the effect of noise in the image.

(The measurement areas have a related auto adjustment function, which adjust the
scale based on the area.)

The rightmost button will keep the distance between the slider controls fixed.

Sometimes, when a live camera image is shown, you can find it impossible to
change the scale in ThermaCAM Researcher. This is when the camera has been set
to continuously adjust the level or span of the image. Please switch that camera
setting off.

Finally, in the Image tab of the Settings dialogue, there are a few more options you
can explore:
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The Show scale option switches the display of the temperature and colour scale
on/off.

The Show analysis labels option will switch the display of the label texts on/off.

The Show 3D-view option will display a pseudo 3D version of the image.

The Update temperatures option has to do with the update of OLE links, profile,
histogram and result table when analysis tools are moved around in the image.

The Get analysis option should not be used unless your images contain analysis
tools that vary from image to image, which normally isn’t the case.

The Zoom factor makes it possible to temporarily enlarge the centre of an image.

7.3.2 Transferring an IR image to ThermaCAM Reporter
You can easily move your IR image to ThermaCAM Reporter. Use the Copy
session and image tool button or the same command of the Edit menu.

Then, open ThermaCAM Reporter and paste the image into it.
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7.3.3 Transferring an IR image with OLE
If you want to display your image in a program not designed for IR images, you
have to use OLE to make it visible. Use the Copy session and image tool button or
the same command of the Edit menu.

Read more about this in OLE in brief on page 114.

7.4 How to trigger ThermaCAM Researcher from
outside
If your target is active only on certain occasions, you might well want to tell the
program when it should examine at the target. Two functions in ThermaCAM
Researcher work under such conditions. The recording functions that collect
images, and the plotting functions that collect measurement results.

They can conditionally record or plot not only at certain times, but also on external
trig pulses. The parallel interface has a trig input connector, which is the default
trig source. In addition, a free COM port or a LPT port can be used as the external
trig source. These are mainly intended for usage with the PC Card Interface.

The external trig increments a trig counter which is stored with each image. The
value of this counter can be displayed in the Play Images tool bar and the result
table. For COM or LPT trigs, the counter only counts one trig pulse per image.

The source for the external trig is selected from the “Dev” tab (or the Recording
Conditions dialogue) in the camera control panels.

External trig using the parallel interface

Please see The parallel interface (PI) on page 25.

External trig using the serial port

This trig source option uses the CTS input line on a free COM port. The COM port
has an RS232 electrical interface.

Trig input using COM1, COM2, COM3 and COM4.

DSUB-25
Pin 5: Trig Input.

Transition Low (<-3 V) to High (>+3 V) =trig.
Close pin 4 and 5 to trig.

DSUB-9
Pin 8: Trig Input.

Transition Low (<-3 V) to High (>+3 V) =trig.
Close pin 7 and 8 to trig.
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Please review the RS232 specification for a more detailed description of the
electrical interface.

External trig using the printer port

The printer port (LPT) option is only available on Windows 95/98/ME platforms.
This trig source option uses a control signal on a free LPT port. The LPT port has a
TTL electrical interface.

Trig input using LPT1 (or LPT2) DSUB 25 pin printer port.

Pin 10: Trig Input. Open circuit = high. (+2.4 V to + 5 V)
Transition High -> low =trig.

Pin 22: Ground Closing 10 - 22 = trig.

The LPT1 port is normally associated with the physical hexadecimal address 378
and the LPT2 port is associated with address 278. The camera control assumes that
this is the case. Check your parallel port configuration in the Control Panel, System
icon, to find out the physical address associated with the parallel port.

7.5 How to record IR images
You can only record images that come from the camera interface. The currently
active measurement tools are not recorded with the images, but the current scale
and object parameters are.

You have to push the camera button in order to get live images (or select Show
Camera Image from the Camera menu or press Ctrl + L on the keyboard).

7.5.1 The Recording tool bar
When the camera becomes the image source, the following tool bar is displayed.

 

It is primarily associated with recording sequences of image files, but can also be
used to record single image files. The leftmost field shows the name of the file that
will be stored next. The name consists of a base part (TEST) to which a sequence
number is added (0001) and extension is appended (.IMG or .SEQ). The base part
is a text string, which you can change in the Recording Conditions dialogue
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window hidden under the stopwatch button on the same tool bar. The sequence
number is controlled by ThermaCAM Researcher and is increased by 1 for every
image file or image sequence file.

A field showing the current condition for starting the recording follows the tool
button with the start pistol.

A field showing the current condition for recording an image follows the tool
button with the diskette. No matter what the field says, the diskette button will
always record one image, even if the start condition is not fulfilled.

The next button will temporarily stop the recording: Pause.

A field showing the current condition for stopping the recording follows the tool
button with the chequered flag. No matter what the field says, the flag button will
always stop the recording.

The second last button will bring up the Recording Conditions dialogue window.

The very last button will start the replay of the recorded images in another copy of
ThermaCAM Researcher.

To start the replay of the recorded images in the current copy of ThermaCAM
Researcher, just press this button in the standard tool bar:

7.5.2 The Recording Conditions dialogue
You can reach this dialogue from the Recording tool bar and the Conditions item
of the Recording menu.



 ThermaCAM Researcher 2001 Operating Manual

66

This dialog has two shapes, depending on the camera used. They are functionally
the same.

Recordings are controlled by three conditions: Start, Record and Stop. In this
dialogue you can set these conditions as well as the base part (Auto name) of the
file names and the directory where the recording shall be made. If you select the
Sequence file option, images will be recorded to a single file, which will reduce the
number of files to handle and increase the recording speed. The dotted button
beside the current directory field leads to a directory browser.

Sequence recordings can start at:

• Tool button

• At key trig F5

• At HH:MM:SS. Fill in a time within the next 24 hours like this: “11:23:45”

• External trig (plus a specified delay: for instance “00:00:05”)

Images can be stored either:

• At highest possible speed. This means that no images will be displayed during
the recording, unless you select the Enable Image Presentation option. That
will however reduce the recording speed.

• At HH:MM:SS interval. Example: “00:05:30”

• At key trig F5. This choice will disable the start or stop conditions

• Every N:th image
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• At external trig

The recordings will stop when the stop condition is reached. The following
possibilities exist:

• Tool button. (The flag button is always active during a recording.)

• After XX stored image(s). Fill in the number desired like this: “88”

• After time interval HH:MM:SS. Fill in a time like this: “00:10:00”

• At key trig F5

• At external trig (plus a specified delay: for example “00:00:05”)

For more information about how to connect an external trig, see How to trigger
ThermaCAM Researcher from outside on page 63.

Recording on external trigs is very hard work indeed for ThermaCAM Researcher.
Your computer may appear to respond slowly while these recordings are in
progress.

You might find it a bit difficult to get your recording conditions right if your
camera is capable of producing images at a higher speed than the 50/60 Hz set by
the video standard.  At the higher speeds, the camera puts several images into
every normal speed image sent to the frame grabber. The frame grabber will still
grab its images in the normal way, throwing away the extra information sent by the
camera. You will only get hold of the high-speed images when using “at highest
speed” recording and the “into one file” option.

If your recording will last for a very long time, it might be a good idea to control it
by OLE Automation instead.

7.5.3 Full burst recording of images
Only when you are using full burst recording, can you grab, store and study every
image captured by the camera (except for the old Thermovision 1000).

If you have the parallel interface configuration and suitable SCSI disks and
software, see Software limitations on page 27, you should be able to get a full burst
recording rate if you

• Check the Sequence File / Images in one file checkbox in the Recording
Conditions dialogue.

• Do not run any program that consumes processor power at the same time, for
example "fast find".
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• Do not run any program that consumes lots of memory (such as the Office
programs) at the same time.

• Do not let the local area network connection interfere. (Pull the plug!)

• Do not let the screen saver / lock screen software interfere.

In short, don't let the computer do anything else at the same time.

When you use an external trig to control the burst recordings, these restrictions
have to be observed even before the actual start. ThermaCAM Researcher will
capture all images in advance in order to be able to store the trigged image(s).

7.5.4 OLE Automation recording of images
If you intend to record images at a slow or irregular rate, or wish to do switch
off/on the Stirling cooler or to perform an Internal Correction of the camera before
each “shot”, then OLE Automation controlled recording will be your natural
choice.

You need to have another program available with a Visual Basic for Applications
(VBA) macro language capability that can give orders to ThermaCAM Researcher.
Here is an example for Microsoft Excel, in which 20 images are recorded to disk
using a 15-second time interval:

Sub SaveIR()
  Dim sess As Object
  Dim counter As Integer
  Set sess =
   GetObject("C:\Program Files\Research\Ole.irs")
  Counter = 0
  Do While counter < 20
    counter = counter + 1
    sess.RecordOneImage
    Application.Wait Now + TimeValue("00:00:15")
  Loop
End Sub

7.6 How to play back images
ThermaCAM Researcher does not only handle images recorded by the program. It
is also possible to show images taken directly from Thermovision® 400, 550/570,
900 and 1000, AGEMA 550/570, Prism DS, ThermaSNAP, ThermaCAM PM
1X0, 2X0 and 3X0, UltraCAM PM X95, ThermaCAM PM 525, 545, 575, 595,
675, 695, ThermaCAM SC 1000, 2000 and 3000.



ThermaCAM Researcher 2001 Operating Manual

69

Such images are received by ThermaCAM Researcher on disk.

When ThermaCAM Researcher is showing disk images, the “Play recording” tool
button on the standard tool bar is depressed:

There are several ways in which a playback of images can be initiated. When a
recording is finished, you can press “Play recording” or, on the recording toolbar,
press the button “Play in a new window”:

From the file menu, you can select Open Session, and read a session file from disk
containing information from older, already stored sessions containing recordings.
You can also copy and paste a recording session from one ThermaCAM
Researcher window to another. Furthermore, you can drag and drop image files or
a session file from the Windows Explorer onto a ThermaCAM Researcher window.
Finally, you can use the Open Images function to put together a new selection of
images (or change an existing one).

Let us examine that last method a little.

7.6.1 The open images dialogue
You start the dialogue with this tool button (or by pressing Ctrl + I keys or by the
File and Image menus.)
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It will bring up the following dialogue window:

The top field of this dialogue permits you to edit the name of the directory where
the images are stored. Press OK or the Enter key once after editing this text in
order to refresh the dialogue. The dotted button leads to a directory browser.

The left half of the dialogue shows the list of images currently in use by this
session.

The right half of the dialogue shows a list of image file names in the image
directory. All the files in this list are highlighted by default.

There is a file name filter field by which you can affect the directory listing. You
could for instance change *.img to t*.img to list files beginning with the letter t.
Press OK or the Enter key once to refresh the list afterwards.

If you select the View Thumbnails option, the layout of the right half of the dialog
will change drastically:
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The list of files will become a list of images instead. The images with a blue frame
are the highlighted ones. The images are always displayed with the iron palette and
with their own scale, object parameter, analysis and zoom settings. As you can see,
some of these images contain box area tools.

Using the three radio buttons below the images, you have the option of displaying
the date or time instead of the image names.

The buttons in the middle of the dialogue manipulate the names of the list to the
left. The << Add button will copy all highlighted file names from the right list to
the left one. The Clear All button will clear the left list. The Deselect button will
remove highlighted items in the left list. If no items are highlighted, nothing is
removed. The image files are not deleted from disk by this operation, only their
names in the list.

The Sort selection will rearrange the names in the left list. They become sorted in
alphabetical order and duplicate names are removed.

This gives you the possibility to arrange the list of names, as you like.

You should use mouse clicks in combination with holding down the Shift or
Control keys in order to manipulate the highlighting of the lists.

You may add both single images and image sequence files to the left list at the
same time, although it is probably not very common practice.
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When pressing OK, you select all the image files in the list to the left for playback
by ThermaCAM Researcher. This action activates the Play images tool bar.

7.6.2 The play images tool bar
When disk images are being replayed, this tool bar is displayed.

It resembles the controls found on ordinary video tape recorders quite a lot.

You can step forward and backward one image at a time. You can play your
images in any direction fast or slowly or jump to the end/beginning of the images.

You set the replay rate by the “*1” control.
”*1” means full speed from disk.
“*2” means twice full disk speed (i.e. every other image is not shown) and
“÷2” means half full speed.

You can double-click on the control to make it return to ”*1” speed.

These two buttons let you select one part of the current images. Press the left one
when you are looking at the first (leftmost) image to be selected. Press the right
one when you look at the last (rightmost) image to be selected. A blue indicator
will mark your selection in the control.

When you have marked a selection, the "to end/to beginning" buttons will instead
jump to the next mark and the autorewind button will change its behaviour.
Printouts can be made based to the selection and, in the case of a sequence file
being displayed, editing of this file can take place.

You can remove the selection by choosing Clear Markers in the Recording menu

This button enables Autorewind mode. If a selection is made, it will be repeated
continuously when replayed. If no selection is made, or AutoRewind mode is set
to “All images”, the whole sequence is repeated.

The text field to the left shows the name of the current image in the sequence. This
field can be edited if you click in it. You may write:

• A file name, including the extension, present in the list.
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• The number of a particular image. 1 signifies the first image.

• A relative number. “+5” means five images ahead. “-12” means twelve images
back.

Hit Enter on the keyboard to finish the editing.

For information about associated shortcut keys, see Shortcut keys on page 49.

These four buttons control how the program behaves when you switch from one
image to another. Read more about them in Making measurements in playback on
page 101.

7.6.3 The Replay Settings dialogue
If you choose Replay Settings from the Recording menu the following dialogue
will appear.

AutoRewind mode. In rewind mode you can chose between repeating the whole
sequence or just the marked part.

Presentation. (What is presented on the play images tool bar.)
"Absolute time" shows the actual recording time.
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"Time relative to first image" shows the time difference of the current image
compared to the first image. If the current image is recorded earlier than the
first image, ######## is shown instead.
"Image number" shows the image ordinal number.
"Trig count" shows the external trig count stored in the image.

7.7 How to edit/convert sequences
It will happen now and then that you record too many images and would like to
extract the essential part of a sequence and/or convert it to some other image
format, such as avi or bmp.

To edit a sequence of images, open it with the Open Images dialogue and use the
Selection Start/Selection End buttons on the Play Images toolbar to mark some
images. Step to the first image you intend to edit and press the left one of the
buttons, then step to the last image to edit and press the right one. A blue ribbon
will be shown in the Image Slider control.

7.7.1 Removing/Copying all selected images
Having selected some images, you can choose Remove Selection  from the
Recording menu. Then you will be prompted to confirm it is the right selection.

You cannot undelete images that become removed. Depending on the sequence
size this operation may take several minutes. The frame numbers of the images
following the removed part will be resequenced.

Removing images only works if all the images are in the same sequence file (.seq)

Instead, if you choose Copy Selection  from the Recording menu, and then choose
output format "Seq", you may select a directory and enter a file name for the new
sequence file. Depending on the size of the selection this operation may also take
several minutes.

Copying images in this way only works if all the images are in the same sequence
file (.seq)

7.7.2 Removing/Copying some selected images
Having selected some images, you can also choose Reduce Selection  from the
Recording menu. This dialogue will appear:



ThermaCAM Researcher 2001 Operating Manual

75

If you move the slider in the centre of the dialogue to the right, more of the
sequence file is kept. If you move it to the left, less is kept.

Select whether or not you wish to copy the sequence to a new file, and press OK.

You cannot undelete images that become removed. Depending on the sequence
size this operation may take several minutes. The frame numbers of the images
following the removed part will be resequenced.

The reduction works only if all the images are in the same sequence file (.seq)

7.7.3 Avi/Bmp/Matlab/FPF files from selected images
Having selected some images, you can convert them to other image formats by
choosing  Copy Selection  from the Recording menu. This dialogue will appear:
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Please set the output directory, output name and options of preferred output format
and press OK to start the copy. Depending on the size of the selection this
operation may also take several minutes.

You can read more about various output formats in Studying whole images on
page 96.

If you press the options button when the output format is Avi, you will be able to
set the Avi codec to "other". This, in turn, causes the Copy Selection dialogue to
show the following dialogue when you press its OK button.

Here you can choose among the compressors installed in your computer and
configure them. Please note that some of them might only be able to decompress
avi files, not to compress the files.

Cinepak Codec is a fairly common compressor, but does not produce that good
images. The MS Video 1 compressor makes better images, but is less common.

You should always check that the receiver of the avi file is able to decompress it.
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7.7.4 Subtracting selected images
Regarding image subtraction as an image conversion function might seem strange,
but that is really what this type of work is all about. You select some images out of
a sequence, order them to be subtracted and get another sequence containing
difference images as the result.

Why subtraction? Well, the most important usage of this function is for making
comparisons. You can compare images of the same (or similar) object(s), taken at
different times, in order to detect changes in temperature, position or shape.

Subtraction uses a reference image, taken when conditions are known to be good,
in some sense, and subtracts the selected images with that reference. The
subtraction is made in the current measurement unit, not in camera signal.

The reference image does not have to be located in the same directory as the
selected images. The output images are put in the same directory as the selected
ones, however.

To make a subtraction, select “Subtract Sel Images” from the Recording menu.
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On the dialogue shown, you can see most of the settings of the subtraction
function, and also preview the subtraction by (slowly) pulling the slider. No images
will be saved on disk until you press the “Save output” button.

The Source Images shown in the upper left corner are the ones you selected before
starting the subtraction. The Reference Image is displayed in the upper right corner
and the resulting image in the bottom left.

Please press Settings, to view the settings dialogue.

The first tab contains settings for
the actual subtraction algorithm.
You can invert the result, force a
particular output scale and apply
an offset (in case your images
were taken under very different
atmospheric conditions).
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The second tab contains settings
for the reference image. You can
either use the first selected source
image as your reference or
perform consecutive subtractions
or use a separate reference image.

In the last case, use the open
button to open your image and
the slider to find it, if it is inside a
sequence.

In the output tab you can set the
name base for the output images.
A number will be appended to
the base, to make the name
unique.

When the subtraction is finished,
you can, at will, open and select
the output images, close all
previous source images and a
new palette to the images.

There are two special purpose
subtraction palettes. Midgrey and
Midgreen. Since the 0-level of a
difference image normally is in
the middle of the scale, there has
to be a neutral colour for that
value.

Please press OK to return to the Subtraction dialogue. Now, press “Save Output” to
get the subtraction going.

While the images are being subtracted, a progress bar is being displayed.
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When the subtraction is over, and the output images are displayed, you may notice
that the measurement units have changed. From °C to dC, for instance. This is
because there is no longer any absolute temperatures in the real sense. Just
differences indicating how much the temperature of the object has changed.

You may also notice that most of the object parameters have lost their meaning.
Only the object distance is valid for difference images.

If you are very unfortunate, you may also notice that there was overflow in the
subtraction. Subtraction has a limit, which normally is ±400 dC. You can use the
offset to get around that limit, if it is disturbing.

Subtraction is an operation that can’t be undone. This means that if you find out
that something (an object parameter perhaps) of the source or reference image was
wrong, then you have to change it and run the subtraction once again to get
accurate results.

7.8 How to make single image measurements
Sometimes you just need to look at an IR image to measure it. You can look for
anomalies, hot or cold areas and get an impression of their temperatures just by
comparing the colours with those of the temperature scale. By choosing a suitable
scale and palette, such things can be made to appear quite clearly. This chapter
will, however, be devoted to something else: how to use the analysis tools to get
numerical temperatures and statistical information out of a single image.

The analysis tools will show their results in the result table, plot, profile or
histogram window or directly inside the IR image. Results are also available
through the OLE functions, such as Copy Value.

Both absolute measurements (i.e. the result is a real temperature) and relative
measurements (i.e. the result is a difference temperature) can be made. The relative
measurements are made relative to the reference temperature that you can enter in
the dialogue window Image Settings (in the Image menu), the Object Parameters
tab. Relative measurements are only available for some camera types

The analysis tools work both with live images and recorded images.

The analysis tools are applied by activation of one tool button at a time. These are
in this tool bar:

When you click on one of these buttons (except the formula button), it will stay
depressed until you have “drawn” the analysis tool inside the IR image or the
colour scale. If you change your mind, click on the button again, and it will pop up.
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If you hold the Ctrl-button of the keyboard down while placing the tool on the
image, the button will stay down and you will be able to continue adding another
tool of the same kind. The removal button works in the same way.

Once the symbols have been drawn, you get the opportunity to bring up a menu for
each symbol by "hovering" with the mouse cursor above the symbol and clicking
with the right mouse button. The symbol will respond by changing its colour (and
the mouse cursor) when you can catch it.

Formula results are not presented in the IR Image, instead they are available in the
result table, plot and through OLE functions.

Three of the tool buttons are equipped with menus that you can activate by moving
the mouse a little before releasing the mouse button. This is indicated with a small
arrow facing downward on those buttons.

7.8.1 The isotherm tool
An isotherm is a marker in an infrared image that highlights areas where the
radiation from the object is equal. The name isotherm can be misleading, since it
implies that equal temperatures are highlighted. This is only true if the emissivity
of the object is the same all over the image.

If you bring up the menu on this button, you will see that there are five types of
isotherms in ThermaCAM Researcher. The most commonly used one is the
interval isotherm. It will highlight a temperature interval with a certain (selectable)
width. There is a marker in the colour scale to indicate the position of the isotherm.
The temperature measurement value associated with the interval isotherm is taken
at the top of the isotherm, regardless of how wide it is.

The Above isotherm will highlight all temperatures above a temperature value and
the below isotherm the opposite.

Dual above and Dual below isotherms are an above/below isotherm attached to an
interval isotherm with a different colour. The Dual isotherms highlight two
temperature spans.

You activate the tool and set its level by clicking on the colour scale beside the
image. If the scale has been switched off in the Image Settings dialogue, you have
to switch it on again.

Isotherms can be viewed in a transparent mode: Select the Analysis tab from the IR
objects settings dialogue, mark the transparent isotherm check box.
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Transparent isotherm is best viewed with a grey palette, because the isotherm will
always be presented in the image with red for above, green for interval and blue for
below. If two isotherms of the same kind are present, the latest added isotherm will
be shown in yellow.

It is possible to change the isotherm level after it has been created. You “catch” the
level in the colour scale by pressing the left mouse button precisely on the level
and pull it to where you want it to be. Then release the left mouse button. The
interval isotherm can be changed in three ways. You can catch it in the upper and
lower ends, changing them. You can also catch it in the middle and move both
ends at the same time.

Isotherm limits cannot exist outside the maximum or minimum temperatures of the
scale. Hence they will follow the scale limits, if the span of the scale is reduced.

You can use two isotherms with different colours at the same time.

The temperature values of the isotherm are shown in the result table window or
through OLE. You can obtain the following values: Temperature, Width (interval
isotherm only) and Temperature relative to the reference temperature.

The temperature value given for the interval isotherm, is that of the upper limit.

The isotherm always uses the object parameters of the IR image.

7.8.2 The spot meter tool
This tool measures the temperature in one spot on the image and shows the result
in the result table or beside its symbol in the IR image. The results are also
available through OLE. You can obtain the following values: Temperature,
Temperature relative to the reference temperature, Emissivity, Object distance and
the image co-ordinates of the spot meter.

Spot meters are called SP01, SP02...SP99.

You create a spot meter by first clicking on the spot meter tool button and then on
the desired position in the image.

You move a spot meter by “catching” it with the mouse. You press the left mouse
button on top of the cross hair and drag it into the place you want. The spot meter
will then jump to that position.

7.8.3 The flying spot meter
This tool only measures the temperature at the mouse cursor and displays it beside
the cursor in a tool tip window.
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There is just one single flying spotmeter.

You can click with the left mouse button on the image to create fix spotmeters in
that position, if you like.

7.8.4 The area tool
This tool measures the maximum, minimum, average and standard deviation
temperature within a chosen part of the image and presents these values in the
result table window or beside its symbol in the image. Results can also be
displayed graphically in the histogram window. The results are also available
through OLE.

You can obtain the following values: Minimum, Maximum, Average and Standard
deviation temperature, the same relative to the reference temperature (except for
the deviation), Emissivity, Object distance and the image co-ordinates of the area.

Areas are called AR01, AR02...AR99.

You create a box area by first clicking down the box button and then moving the
mouse to one of the corners of the new box. Press the left mouse button down and
drag the mouse to the opposite corner and release the button.

You create a circle area by first clicking on the circle button and then moving
mouse to the centre of the new circle. Press the left mouse button down and drag
the mouse to some place on the circle border and release the button.

You create a polygon area by first clicking on the polygon button and then moving
mouse to the first corner of the new polygon area. Click the left mouse button for
each new corner and double click or hit the Esc key to finish adding corners.

You move an area by “catching” it with the mouse. You press the left mouse
button down inside the area and drag the whole area into the new position and
release the button.

You reshape an area by catching the border or corner to be changed and dragging it
along. Catching and dragging a polygon area border results in adding a new corner.
You can remove a specific corner from a polygon area by using the analysis
removal tool.

Areas can also be used to make Local Auto Adjustments. That means adjusting the
scale of the whole image to the temperature span within that particular area. It is
very useful, if you want to make detailed studies of some part of the image. This
function is only available on the right mouse button menu of the areas.
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7.8.5 The line tool
This tool measures the minimum, maximum, average and standard deviation
temperature along a straight or bendable line within the image. The temperature in
one spot, the line cursor, can also be measured. These values are presented in the
result table or beside the line symbol in the image. The line temperatures can also
be graphically presented in the profile window. The results are also available
through OLE. You can obtain the following values: Cursor, Minimum, Maximum,
Average and Standard Deviation temperature, the same relative to the reference
temperature (except for the deviation), Emissivity, Object distance and the image
co-ordinates of the line and a string with all the temperatures of the line.

Lines are called LI01, LI02...LI99.

You create a straight line by first clicking on the line button and then move the
mouse to one of the ends of the new line. Press the left mouse button down and
drag the mouse to the other end and release it.

You create a bendable line by first clicking on the line button, and then drag the
mouse just a little. A menu will now appear. Select the “Bendable line” item and
start clicking on the image wherever you want the corners to be placed. Double-
click with the mouse or press the Escape key to finish the creation.

You create a line cursor by first pressing the left mouse button on the line tool
button while dragging the mouse to bring up the menu. Select the “Cursor” item
and move the mouse to the place on the line where you want to have the marker
and click. You can see the temperature of the marker now in the profile window.

You move a line by “catching” the corners with the mouse. You press the left
mouse button down on the corner and drag it away. Release the mouse button
afterwards. You can move the whole line by catching it in the middle.

You move its cursor by “catching” it and dragging it along the line.

7.8.6 The Formula tool
This tool is used for adding and editing formulas.

A formula can contain all common mathematical operators and functions, such as
+, -, *, / square root, etc. Also, numeric constants such as 3.14 can be used. Most
importantly, references to measurement results, formulas and other numerical data
can be inserted into formulas.

The formula button has a menu. If you bring up the menu you will find some
frequently used formulas to add, in addition to entries leading to an add formula
dialogue and an edit formulas dialogue.
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The result of the formulas appears in the result table. You can also plot the result.

Please select the Formulas tool button. The Edit formulas dialogue box will appear.

Click Add, and another dialogue shows, in which you define your new Formula.



 ThermaCAM Researcher 2001 Operating Manual

86

The formula name is generated automatically and identifies the formula uniquely.

In the Label field, type a text describing your formula. This label will appear in the
result table window.

Now, enter the expression of the Formula. You may either type in the expression
using the keyboard, or use the buttons in the dialogue box. When you click on any
of the buttons, the corresponding operator will be inserted into the expression.
Following are the operators that can be used.
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Operator Button Operator

Plus operator

Minus operator

Division operator

Multiplication operator

Power operator

, 
Parentheses, used for grouping

If you want to use other mathematical operators, such as sinus, select the
appropriate function by clicking the Math button. Following are the functions that
can be used.

Function Name Function

sqrt Square Root

log Natural Logarithm

log10 Base-10 Logarithm

sin Sinus

cos Cosinus

tan Tangent

Asin Arcsine

Acos Arccosine

Atan Arctangent
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Typically, your Formula will contain references to other sources of data, such as
measurement functions of IR images. To select a data source, click the Connect
button. A dialogue will appear. Select the Object and Value, and click OK. This
will insert a reference address into your expression. The address will be substituted
with the actual value when the Formula is used.

For the example above, with the spot and area items, you would do the following
to add a Formula that is defined as the subtraction of the spot temperature and the
area’s average temperature:

• Type a suitable label for the formula in the Label field, such as “Spot - Area”

• Click the Connect button. Select “Spot” from the Object list and
“Temperature” from the Value list and click OK. This will insert the address
“{sp1.value}” into your expression.

• Click the button labelled “-”. This will insert a minus sign into your expression.

• Again, click the Connect button. This time, select the “Area” from the Object
list and  “Average temperature” from the Value list and click OK.

Your expression should now read “{sp1.temp} - {ar1.avg}”.

You may also specify the precision of the formula, i.e. the number of decimals
with which the result of the formula will be displayed. Do this by selecting the
appropriate value from the Precision list. You can use 0 - 5 decimals.

Once finished, press the OK button. This brings you back to the Formulas
dialogue. To add more formulas, repeat the procedure.

Another interesting formula you could try, is
     “({sp1.temp}^4) * 5.57033e-8 / 3.141592 [W/m^2/sr]”
which calculates the blackbody radiance, when the temperature is in Kelvin.
(5.57033e-8 means 5.57033*10^-8)

The command Change gives you the opportunity to change a defined formula.
Selecting a formula is done by clicking on it. Double clicking it will open the
Change Formula dialogue box directly. The Delete button removes the selected
formula.

Note: Any text that follows the expression will be displayed, as is, in the field
connected to the formula. For instance, your expression may be “{sp1.value} *
{dobj} meters”.
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7.8.7 Removal of analysis tools
You remove analysis tools by pressing the removal tool in the analysis tool box
down, i.e. the red X. You then move the mouse to an analysis tool and click to
remove it. All analysis tools including line cursors and isotherms can be removed
in this way.

If you happen to press this button by mistake, click on it again to deactivate the
function.

In the Image menu, there is a command that will remove all the active analysis
tools (formulas excluded) at once. All the active formulas may be removed by a
separate command in the Image menu.

7.8.8 Analysis tool styles and object parameters
You can affect the way in which analysis tools appear in the image. You can also
change some of the object parameters used. Press this button to bring up the Image
Settings dialogue window or select Settings from the Image Menu.

The Analysis tab looks like this:
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First, use the list in the top left corner of the dialogue to select the appropriate
analysis tool.

Then, write some short descriptive name in the text field below, unless you think
that LI01 will do. This text will be shown beside the analysis symbol.

Further down the dialog, there is a list box that allows you to display one
measurement result beside the analysis symbol.

If you click in the “Solid label” box, the text beside the symbol will be shown on a
black background. This increases the visibility but hides more of the image.

You can also change the colour of the analysis symbol, in case it happens not to be
visible enough.

Frequently, the object emissivity or distance is varying between different parts of
the IR image. All analysis tools (except the isotherm) can be forced to use their
own values on these object parameters. Click in the box to the left of the parameter
to enable the function and fill in the desired value to the right. The value shown
before was the corresponding value of the object parameters of the image.
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The threshold temperature is described in Using a threshold on page 110.

You may change more than one analysis function before clicking OK.

7.8.9 Emissivity calculation
The emissivity factor of an object can be calculated if you know its temperature
and the temperature value is well above or below the ambient temperature.

Put for instance a box area on the object for which you know the temperature.
Select "Emissivity Calculation" from the right mouse button menu of the area.

Enter the known temperature and click on "Calculate" to view the new emissivity.
Press OK to accept and apply the new emissivity to the area.

7.8.10 The result table window
The result table presents measurement data from the IR image and from the
analysis symbols. You can switch on/off the presentation of specific values from
the settings dialogue reached by the right hand mouse button of the mouse.
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The analysis tab

Analysis symbols having their own object parameters have their labels marked
with an asterisk.

If the difference temperature option is available and checked in the settings
dialogue, then the reference temperature is shown on the first line in the Temp.
column. Results affected by the reference temperature are displayed on two lines,
one line subtracted by the reference temperature and the other one as usual.

The expression and result columns present formulas and the result values.

The position tab

This tab shows the coordinates for spots, lines and areas. All coordinates are
relative to the IR image top left corner. For a polygon area, the coordinates are
those of a circumscribed rectangle.

The object parameter tab

The IR image object parameters are always shown according to the settings
dialogue. Analysis symbols having their own object parameters are also shown.
Their labels are marked with an asterisk.
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The image tab

The image tab shows IR image data. From the settings dialogue, select a set of data
to be shown.

7.8.11 Interpretation of *>< values
Sometimes, when you accidentally make measurements almost outside the
calibrated range of a camera, or when you enter extreme object parameters, you
will get *s in front of or replacing the desired values. You may also get > or <
characters in front of the values. In all these cases you are out of range.

7.8.12 Transferring single results with OLE
If you want to see result values not shown on the IR image or to process the values
in other programs, then you should use OLE. First you press this tool button, or
select Copy value from the Edit menu:
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This will bring up the Copy Value dialogue window:

Then, click in the left column on the appropriate type of object and fill in the
ordinal number in the text box below. SP01 corresponds to spot object 1. Click in
the right column on the desired value.

Press "Copy" and this value can now be copied (or even linked) into other
applications.

7.8.13 Transferring the result table with OLE
Click inside the result table window with the right hand mouse button and select
Copy. In the receiving application, for example Excel, select Edit Paste. The whole
result table is transferred.

7.8.14 Measurement output and units
You can select the temperature unit and distance unit you want the analysis tools to
work with at the Units tab of the Image Settings dialogue that you bring up from
the Image menu or with this button:

The temperature unit is also used in the temperature scale.
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From the same dialog, you can also set the preferred measurement output:

• The temperature value is calibrated with a set of reference blackbodies.

• Object signal is a non-calibrated value approximately proportional to the
amount of radiation sensed by the detector. It will change from camera to
camera and between the measurement ranges.

See also: Units of measure on page 39.

7.8.15 Inheriting the analysis tools of cameras
Some versions of some cameras are equipped with analysis tools. When such a
camera is electrically connected to ThermaCAM Researcher, none of them are
transferred to the PC, only the image. However, if there is a PC Card hard disk in
the camera, you can store images on it and move the PC Card disk to the PC, open
the images and in some cases get the analysis tools transferred. You only need to
release the following button on the “Play images” tool bar in order to see the
analysis tools stored in each image:



 ThermaCAM Researcher 2001 Operating Manual

96

7.8.16 Studying whole images
Users of MatLab or Excel will find it convenient to be able to study images
themselves. The selection Save As in the Image menu leads to a dialogue in which
the current image can be saved in various formats:

• MatLab format, with one double precision value for each element of the image
(see Studying whole images with Matlab).

• FLIR Public Format File format, with one single precision value for each
element of the image (see The FLIR Public image format).

• Bitmap format, with or without analysis. Can only be used to view the images.
• Csv format. The temperatures of the whole image is stored in a text format that

Microsoft Excel can read. The character that separates the temperatures in the
file is fetched from the Windows regional settings.

Note: There is also the "Save Tab As" command in the File Menu, which saves the
current tab (i.e. both the image and the adjacent graphs) as a bitmap file.

7.8.17 Studying whole images with Matlab
ThermaCAM Researcher uses a simple Matlab matrix format. The binary file
begins with five 4-byte integers structure. This is how it is described in C++:

typedef struct {  // MatLab file header (level 1.0)
   long type;     // 0 Intel type
   long mRows;    // Image height
   long nCols;    // Image width
   long imagF;    // 0 No imaginary part
   long namLen;   // Length of the matrix name + 1
} MatLabHeader;

This is followed by the name of the matrix, which corresponds to the name of the
.mat file. This name must begin with a letter and not contain any strange
character for Matlab to be able to read the file.

The name is followed by nCols*mRows 8 byte double precision float numbers,
each containing the current value of one point in the image, column by column.

XXXX(1,1):              Top left corner of the image

The image value matrix is followed by four extra one column matrices containing
data about the stored image. Example for image XXXX:

XXXX_DateTime(1,1):     Year
XXXX_DateTime(1,2):     Month
XXXX_DateTime(1,3):     Day
XXXX_DateTime(1,4):     Hour
XXXX_DateTime(1,5):     Minute
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XXXX_DateTime(1,6):     Second
XXXX_DateTime(1,7):     Millisecond
XXXX_ObjectParam(1,1):  Emissivity
XXXX_ObjectParam(1,2):  Object distance
XXXX_ObjectParam(1,3):  Ambient Temperature
XXXX_ObjectParam(1,4):  Atmospheric Temperature
XXXX_ObjectParam(1,5):  Relative Humidity
XXXX_ObjectParam(1,6):  Computed atm. transmission
XXXX_ObjectParam(1,7):  Estimated atm. Transmission
XXXX_ObjectParam(1,8):  Reference Temperature
XXXX_ObjectParam(1,9):  External optics temperature
XXXX_ObjectParam(1,10): External optics transmission
XXXX_Scaling(1,1):      Blackbody range min
XXXX_Scaling(1,2):      Blackbody range max
XXXX_Scaling(1,3):      Type of output
                         0 = temperature
                         2 = difference temperature
                         4 = object signal
                         5 = difference object signal
XXXX_Scaling(1,4):      Camera scale min
XXXX_Scaling(1,5):      Camera scale max
XXXX_Scaling(1,6):      Calculated scale min
XXXX_Scaling(1,7):      Calculated scale max
XXXX_Scaling(1,8):      Actual scale min
XXXX_Scaling(1,9):      Actual scale max
XXXX_FrameInfo(1,1):    Image number
XXXX_FrameInfo(1,2):    Trig count

7.8.18 The FLIR Public image format
The "xxxx.fpf" files consist of a header followed by a matrix of single precision
IEEE floating point values, each representing one point of the image.

A C-style description of the header layout can be found in the header file fpfimg.h,
available in the Examples sub-directory of the installation.

The image point values are stored starting from the top left corner, row by row.

Fpf images can only be saved by ThermaCAM Researcher, not read again.

The basic data types are:

Char 8 bit Often represents ASCII characters,
may represent an 2's complement 8 bit integer
(-128 - +127)

Unsigned char 8 bit 8 bit integer number (0 - 255)
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Short 16 bit 16 bit integer (2's complement)

Unsigned short 16 bit 16 bit integer

Long 32 bit 32 bit integer (2's complement)

Unsigned long 32 bit 32 bit integer

Float 32 bit IEEE floating point number,
sign + 23 bit mantissa + 8 bit exponent,

Representing numbers in the range +/- 1038

Char[<len>] Len * 8 bit ASCII character string, most certainly terminated
with the NUL character (=0)

Int 32 bit 32 bit integer (2's complement)

Multiple byte data types are stored with the least significant byte first.

The whole header data structure: (size 896 bytes)

typedef struct
{
   FPF_IMAGE_DATA_T  imgData;
   FPF_CAMDATA_T     camData;
   FPF_OBJECT_PAR_T  objPar;
   FPF_DATETIME_T    datetime;
   FPF_SCALING_T     scaling;
   long  spareLong[32];    /* = 0 */

} FPFHEADER_T;

The image data structure: (120 bytes)

typedef struct
{
   char fpfID[32];                 /*  "FLIR Public Image Format" */
   unsigned long  version;         /*  = 1 */
   unsigned long  pixelOffset;     /*  Offset to pixel values from
                                       start of fpfID. */
   unsigned short ImageType;       /*  Temperature        = 0,
                                       Diff Temp          = 2,
                                       Object Signal      = 4,
                                       Diff Object Signal = 5, etc */
   unsigned short pixelFormat;     /*  0 = short integer  = 2 bytes
                                       1 = long integer   = 4 bytes
                                       2 = float          = 4 bytes
                                       3 = double         = 8 bytes*/
   unsigned short xSize;
   unsigned short ySize;
   unsigned long  trig_count;      /* external trig counter */
   unsigned long  frame_count;     /* frame number in sequence */
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   long  spareLong[16];            /* = 0 */
} FPF_IMAGE_DATA_T;

The camera data structure: (360 bytes)

/*  String lengths    */
#define FPF_CAMERA_TYPE_LEN   31   /* Camera name string */
#define FPF_CAMERA_PARTN_LEN  31   /* Camera part number string */
#define FPF_CAMERA_SN_LEN     31   /* Scanner serial number string */
#define FPF_LENS_TYPE_LEN     31   /* Lens name string */
#define FPF_LENS_PARTN_LEN    31   /* Lens part number string */
#define FPF_LENS_SN_LEN       31   /* Lens serial number string */
#define FPF_FILTER_TYPE_LEN   31   /* Filter name string */
#define FPF_FILTER_PARTN_LEN  31   /* Filter part number string */
#define FPF_FILTER_SN_LEN     31   /* Filter serial number string */

typedef struct
{
    char camera_name[FPF_CAMERA_TYPE_LEN+1];
    char camera_partn[FPF_CAMERA_PARTN_LEN+1];
    char camera_sn[FPF_CAMERA_SN_LEN+1];

    float camera_range_tmin;
    float camera_range_tmax;

    char lens_name[FPF_LENS_TYPE_LEN+1];
    char lens_partn[FPF_LENS_PARTN_LEN+1];
    char lens_sn[FPF_LENS_SN_LEN+1];

    char filter_name[FPF_FILTER_TYPE_LEN+1];
    char filter_partn[FPF_FILTER_PARTN_LEN+1];
    char filter_sn[FPF_FILTER_SN_LEN+1];

   long  spareLong[16];            /* = 0 */
}FPF_CAMDATA_T;

The object parameters data structure: (104 bytes)

typedef struct
{
   float emissivity;        /* 0 - 1 */
   float objectDistance;    /* Meters */
   float ambTemp;           /* Ambient temperature in Kelvin */
   float atmTemp;           /* Atmospheric temperature in Kelvin */
   float relHum;            /* 0 - 1 */
   float compuTao;          /* Computed atmospheric transmission */
   float estimTao;          /* Estimated atmospheric transmission */
   float refTemp;           /* Reference temperature in Kelvin */
   float extOptTemp;        /* Kelvin */
   float extOptTrans;       /* 0 - 1 */
   long  spareLong[16];     /* = 0 */
} FPF_OBJECT_PAR_T;
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The date and time data structure: (96 bytes)

typedef struct
{
   int Year;
   int Month;
   int Day;
   int Hour;
   int Minute;
   int Second;
   int MilliSecond;

   long  spareLong[16];            /* = 0 */
} FPF_DATETIME_T;

The scaling data structure: (88 bytes)

typedef struct
{
   float tMinCam;         /* Camera scale min, in current output */
   float tMaxCam;         /* Camera scale max */
   float tMinCalc;        /* Calculated min (almost true min) */
   float tMaxCalc;        /* Calculated max (almost true max) */
   float tMinScale;       /* Scale min */
   float tMaxScale;       /* Scale max */
   long  spareLong[16];   /* = 0 */

} FPF_SCALING_T;

7.8.19 Studying parts of images
If one part of image is particularly interesting, you can put a box area around it and
save its temperatures in a text file that Microsoft Excel can read. (.csv format)

This command is called "Save area as…", and is available in the Image menu.

7.9 How to measure many images
The previous chapter was about measurements on single images. Much of what
was said there is still valid and will not be repeated here. This chapter will deal
only with questions arising when several images are involved. Typical examples
are how a temperature varies with time or how two (or more) measurements vary
together.

Two approaches can be used in achieving these measurements. Either you record
images and extract the results while playing them back or you get the information
directly from the live stream of images.
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We recommend that you record images especially if the object you study is
moving, since it can be a tedious task to track the moving object with the analysis
tools. During the recording, you will have to aim and mind the camera focus as
well.

7.9.1 Making measurements in playback
While recording, you often find that the conditions change. It is quite natural to
improve the temperature scale or the ambient temperature value while the
recording is in progress. This information is stored in the recorded images and can
be retrieved during the playback.

Of course you can change the scale and the object parameters even when playing
the images. Then you can choose among the following temperature scales:

• The original scale of the recorded image, the source scale.

• A calculated scale, automatically adjusted to the image.

• A fixed scale.

 This is controlled by one button on the standard tool bar and one on the play
images tool bar:

  

 If you click on the candle, it will become depressed and a new scale will
automatically be calculated for every new image as you play them. If you click
again on the candle releasing it or, if you press down the lock scale button, the
current scale limits will be locked (kept) for every new image. If you release the
right button by clicking on it again, the original scale of the images is shown.

 If you change the scale manually, and forget to press the lock scale button
afterwards, you will be asked: “Do you want to use your new scale for all images?”

 The following options exist for the object parameters:

• The original parameters of the recorded images.

• New, enforced object parameters.

This is also controlled from the play recording tools, using this button:

If it is depressed, the current object parameters are kept for all new images. If it is
released, the original object parameters of the images are used.
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 If you change the object parameters manually, and forget to press the lock object
parameters button afterwards, you will be asked: “Do you want to use your new
object parameters for all images?”

The images recorded by ThermaCAM Researcher do not contain any analysis
tools. Hence, you have to add them while playing the images. This is very well, as
long as the object of interest stands still. You simply add the analysis and save it
with the session file.

But, what if the object is moving?

Should that be the case, we recommend going through the images one by one,
moving/reshaping the analysis tools for each image, and saving them under the
same name. Thus, forcing each image to contain its own set of analysis tools.
There is a Save As item in the Image menu that will do the job.

In order to make ThermaCAM Researcher bother about the analysis of
these images in the future, you have to release the “Lock analysis
symbols” button for this session.

It is also possible for you to “lock” the zoom factor, if you like. Each
image can contain a different zoom factor. By pressing this button, you
keep the same for all images.

 If you change the zoom factor manually, and forget to press the lock zoom factor
button afterwards, you will be asked: “Do you want to use your new zoom factor
for all images?”

7.9.2 Plotting and logging measurement results
Plotting is useful when you wish to illustrate temperature variation over time. Just
look at this graph which shows the temperature decline and increase of a hot and a
cold cup of water.
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To get such a plot, you would add two areas to the live image, switch to
the "Plot" tab and click on this button beside the plot table. Use it to add
the average result of the two areas to the plot graph. Now you will find
that the plotting starts immediately, and at a very high speed.

Press this button to stop the plotting.

When the plotting has stopped, you could start it again with this button,
but never mind that for the moment.

Instead, click on AR01 in the plot table. The line highlights. If you click with right
mouse button on the line, a menu appears from which you can select "Conditions".
This is the dialogue that will appear:
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Here you can control the way each result series is plotted. Set a starting time a few
minutes ahead and an interval of 20 seconds for both areas. If you have connected
an external trig, you might use that start condition instead. Press OK.

For more information about how to connect an external trig, see How to trigger
ThermaCAM Researcher from outside on page 63.

(If you check-mark "Log to file, the results will be saved in a log file (.irp) too, in
text format. You can read such files back into the plot window for examination
later, if you like.)

Use the remaining seconds until the plotting starts to clear the graph by clicking
with the right mouse button on it and by selecting "Clear" from the menu.

When the starting time arrives, the plotting will start and continue until you press
the stop button again, unless you had set some condition that causes the plot to stop
earlier.

To inspect the plotted results, place a cursor on the graph and read the results from
the cursor column of the plot table. Click with the right mouse button on the graph
and select "Cursor" from the menu. You can catch and drag the cursor with the left
mouse button.

If you have plotted many results at the same time, you will find it
convenient to temporarily hide some of them by clicking on this
symbol on the corresponding line of the plot table:
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To inspect the graph in more detail, zoom in and out using these
three buttons. The A-button auto-zooms so the data will fill most
of the graph window. If a particular part of the graph is more
interesting, you zoom into that part by "painting it" with the
mouse. Hold the left mouse button down while you move the
mouse over the interesting part of the graph.

To inspect the graph while plotting still is going on, press this
button. It will prevent the plotting window from auto-scrolling to
the end as soon as new results arrive.

The scaling of the axes and many other settings such as colours
and line widths can be changed if you bring up the settings
dialogue with this button:

To save plot data in text format either log it while it is being plotted  (as described
above) or click with the right mouse button on the line in the plot table and choose
"Save" from the menu.

If you intend to make long plottings, there are a few things worth considering:

• Eventually, the plotting on the screen will slow down the computer. You can
avoid this by switching off the auto-scrolling and have the function plot
outside its window. Then, you won't see the whole graph until the plotting is
finished.

• The temperature drift of the camera is important during long plottings. No
camera will be perfectly stable, but you can improve the situation by running it
until it reaches a steady state.

If you want to make plottings from images stored on disk, please do like this to get
the first image included in the plot:

• Open the images via the Image Menu
• Place your analysis tools on the first image.
• Add the tools to the plot table.
• Set appropriate settings for this plot and clear the graph via the graph menu.
• Open the images once again.
• Forward play the images. (Backward plotting is not supported.)

7.9.3 Transferring plot data using OLE
You can also right click inside the plot window and select Copy. When pasting,
choose either Text or Picture (Enhanced Metafile). The Text option copies the plot
table contents and the Picture option copies the entire plot window in graphical
format.
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7.9.4 Transferring many image results with OLE
If you want to study really intricate things, like plotting the difference between two
temperatures over time or correlating a temperature to some other entity, such as
pressure, then you have to you use a spread sheet program capable of handling
OLE. Assuming that you have access to Microsoft Excel, you should proceed like
this.

Embed ThermaCAM Researcher in a spreadsheet (Insert => Object =>
ThermaCAM Researcher Session) and write an Excel macro in VBA (Visual Basic
for Applications). It will open the right session file in ThermaCAM Researcher
and, in a loop, read the desired measurement values from each image and put them
in a pair of columns of cells. Then use the Chart Wizard of Excel to create a
graphical presentation.

Here is an example of such a VBA macro:

Sub PlaySequence_Click()
    Dim sess As Object
    Dim row As Integer
    Dim col As Integer

    row = 1
    col = 10

    ' Get a reference to the ThermaCAM Researcher object
    Set sess = _
       Worksheets("Sheet1").OLEObjects("Object 1").Object

    ' Move to the first image in the session
    sess.GotoFirstImage

    ' Start a loop that iterates through all images
    ' in the session
    Do While True

        ' Store IR image time and spotmeter temperatures
        ' in the cells
        Worksheets(1).Cells(row, col).Value = _
           sess.GetNamedValue("sp1.temp")
        Worksheets(1).Cells(row, col + 1).Value = _
           sess.GetNamedValue("sp2.temp")
        ' Leave col + 2 for the difference sp02 - sp01
        '
        Worksheets(1).Cells(row, col + 3).Value = _
           sess.GetNamedValue("time")

        If sess.IsLastImage Then
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          Exit Do
        End If

        ' Load next image in the session and
        ' increment the row counter

        sess.StepForward
        row = row + 1

    Loop

End Sub

7.10 How to study temperature profiles

7.10.1 Obtaining a profile
Temperature profiles are useful when you wish to illustrate the temperature
variation across or along an object in the image. You just have to put the line on
the image and switch to the profile window in order to be able to see the profile.
Below the graph, there is a table, in which you can get interesting information
about each line.

a) Profile
b) Temperature scale
c) Line cursor

d) Profile table
e) Chart area
f) Plot area

If you would like to change the way in which the profiles are displayed, you can do
this by the Settings dialogue, available on the right hand mouse button when you
click on top of the profile.
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The profile scale is normally connected to the IR image scale, but can be set
independently or automatically.

The line presentation can be reversed, in case you happened to draw the line in the
wrong direction.

Each line can have a cursor, which is displayed both in the profile window and the
IR image. When you need to find the image position of a certain "bump" in the
profile, add a cursor tool to the line and move it in the IR image until it hits the
bump.

7.10.2 Transferring temperature profile data using OLE
The profile of each line or area is available in table form if you select "String data"
for a line from the Copy Value dialogue of the Edit Menu. In the receiving
application, for example Excel, select Edit Paste Special.

You can also right click inside the profile window and select Copy. When pasting,
choose either Text or Picture (Enhanced Metafile). The Text option copies the
profile table contents and the Picture option copies the entire profile in graphical
format.

7.11 How to study temperature distributions

7.11.1 Obtaining a histogram
The easiest way to assess the distribution of temperatures within an area or along a
line on the image is to look at the histogram, which displays how much of the
area/line that is occupied by a certain temperature interval. You simply put the
area/line on the image and switch over to the histogram window and - there it is!
Below the bar graph, there is a table, in which you select which analysis tool to
display.
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a) The percentage value for each class

b) Class temperature limits

c) Overflow class, marked by a red line by the scale

d) Threshold indicator

e) Underflow class, marked by a blue line by the scale

f) Histogram table, indicating the active histogram

g) Chart area

h) Plot area

If you would like to change the number of class intervals or the top/bottom limit of
the histogram scale, this can be done by the Settings dialogue, available on the
right hand mouse button when you click on top of the histogram. The permitted
number of classes is 2 - 64.

The histogram scale is normally connected to the IR image scale, but can be set
differently. Changing this does not, however, change the class interval limits that
always are determined by the current IR image scale.

Those parts of the area/line that fall outside the IR scale are included in the
overflow/underflow classes.
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If you want to be able to see and compare two histograms at the same time you
must switch the histogram window over to dual histogram mode. Afterwards, you
can select two analysis tools for display at the same time.

7.11.2 Using a threshold
Let's suppose that you are not interested in the full temperature distribution of a
line/area, just in getting to know how much of it that has been sufficiently heated
or cooled. Then the threshold function will suit your purpose.

You can associate a threshold with a line/area from the Analysis Tab of the IR
image settings or the General Tab of the Histogram Window Settings and obtain
the desired percentage from the Result Table Window or the Histogram Window,
if you switch on its presentation. The threshold can also be displayed in the
histogram bar graph.

Temperatures that are equal to the threshold temperature are counted as below the
threshold.

The threshold does not have to coincide with any class limit of the histogram
window.

7.11.3 Transferring temperature distribution data using OLE
The histogram of each line or area is available in table form if you select
"Histogram" from the Copy Value dialogue of the Edit Menu. In the receiving
application, for example Excel, select Edit Paste Special.

You can also right click inside the histogram window and select Copy. When
pasting, choose either Text or Picture (Enhanced Metafile). The Text option copies
the histogram table contents and the Picture option copies the entire histogram in
graphical format.
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8. Menu commands

8.1 The File menu
This menu contains commands related to session files. See Session files, page 42.
You can create new sessions, open existing session files, save the current session,
select a default session, open/add images to the current session (see The open
images dialogue, page 69), print an image and leave the program. You can also
save the current tab as a bitmap file.

8.2 The Edit menu
This menu contains commands related to the clipboard. See Transferring an IR
image to ThermaCAM Reporter, page 62, Transferring an IR image with OLE,
page 63 and Transferring single results with OLE, page 93 or OLE  on page 114.
Pasting sessions into ThermaCAM Researcher is mentioned in How to play back
images, page 68.

8.3 The View menu
This menu lists all the tool bars, the control panels and the status line of
ThermaCAM Researcher. Use this menu to hide and unhide them as you please.

See Program screen layout, page 44, for a description of the tool bars.

8.4 The Camera menu
This menu contains a number of commands related to the connecting and
controlling of the camera. All of them are described in How to connect and control
the camera, page 52, and the following chapters about each camera control panel.

8.5 The Image menu
This menu leads to most commands related to the handling of single images. You
can read about this in The image directory, page 42, The open images dialogue,
page 69, Obtaining a good IR image, page 60, Measurement output and units, page
94, Studying whole images, page 96, Removal of analysis tools, page 89, Studying
parts of images, page 100, and Emissivity calculation, page 91.
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8.6 The Recording menu
This menu contains commands about the recording of images and the playback of
recordings. This is described in How to record IR images, page 64, How to play
back images, page 68 and How to edit/convert sequences on page 74.

8.7 The Help menu
This menu provides you with access to the ThermaCAM Researcher help file,
which happens to correspond to this manual, and with version information about
ThermaCAM Researcher and its components, the IR image control program and
the camera control program.

8.8 The Play Images toolbar menu
This menu pops up when you click with the right mouse button on the play images
tool bar. It contains some of the commands in the Recording menu. This is
described in How to play back images, page 68 and How to edit/convert sequences
on page 74.

8.9 The IR Image window menus
These menu pops up when you click with the right mouse button on the IR image.

If you happen to click near an analysis symbol, you will get a menu for that
symbol. If you click anywhere else on the IR image, you will get a menu with
some of the commands from the IR menu.

You can read about this in The open images dialogue, page 69, Obtaining a good
IR image, page 60, Measurement output and units, page 94, Studying whole
images, page 96, Removal of analysis tools, page 89, Studying parts of images,
page 100, and Emissivity calculation, page 91.

8.10 The Results table window menu
This menu pops up when you click with the right mouse button on the Results table
window. It contains settings for the Results table.

The result table is described in The result table window, page. 91.
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8.11 The Profile window menu
This menu pops up when you click with the right mouse button on the Profile
window. It contains settings for the Profile window.

The profile is described in How to study temperature profiles, page.107.

8.12 The Histogram window menu
This menu pops up when you click with the right mouse button on the Histogram
window. It contains settings for the Histogram window.

The histogram is described in How to study temperature distributions, page 108.

8.13 The Plot window menu
This menu pops up when you click with the right mouse button on the Plot
window. It contains settings for the Plot window.

Plotting is described in Plotting and logging measurement results on page 102.
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9. OLE tricks and tips

9.1 OLE in brief

9.1.1 Copying information to other applications
If you want to copy information in ThermaCAM Researcher to another application
you must first copy the data and put it on the clipboard. There are two commands
on the Edit menu you can use: “Copy session and image” which will copy the
session and the entire IR image and “Copy value” which will load a dialog where
you can select the information you want to be copied.

You can also copy data from the result table, from the histogram window, from the
profile window and from the plot window to the clipboard. Right click in the
corresponding window and select “Copy”.

To control how information is pasted, use the Paste Special command on the Edit
menu in the receiving application.

9.1.2 Linking into other applications
Create a link

• Start ThermaCAM Researcher as a standalone application.

• Save the session as an .irs file.

• On the Edit menu, click Copy session and image to copy the IR image to the
clipboard.

• Alternatively, click copy value and select the value to copy.

• In the other application, click where you want the linked ThermaCAM
Researcher Image to be placed.

• On the Edit menu, click Paste Special.

• To paste as a link, select the Paste Link option and Picture Object.

• Click OK.
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9.1.3 Embedding into other applications
Create an embedded object

• Start the application in which you want to embed ThermaCAM Researcher.

• Click where you want to embed ThermaCAM Researcher.

• Open the dialog where you insert objects. It depends on the application how
this dialogue is loaded. In Excel and Word you click Object in the Insert menu.

• In the Object Type box, click ThermaCAM Researcher Session.

• Click OK.

Edit an embedded object

Double-click the ThermaCAM Researcher Session object to open it for editing.
The menus and toolbars in the application are replaced so that you can edit the
embedded object in place.

9.1.4 Automation
By using OLE Automation, it is possible to manipulate ThermaCAM Researcher
from the outside. You can instruct ThermaCAM Researcher to load images, query
it about temperatures etc.

This interface is available from many programming languages such as Visual Basic
for applications VBA (used in Excel), VB script (available in Windows 98, Me and
2000) and "ordinary" Visual Basic.

Some examples can be found in the Excel samples that are installed in the Example
directory (a subdirectory to that ThermaCAM Researcher installation directory).

A full Visual Basic project is included in the VBDemo directory of the CD-ROM.

The on-line help texts of ThermaCAM Researcher describe the OLE Automation
commands in detail.

There are many books on the market that describe VBA and how to use it in e.g.
Excel.

9.2 OLE caveats
If ThermaCAM Researcher is embedded or linked to the Microsoft Office
programs, e.g., Word or Excel there might be some strange behaviours you didn’t
expect. The main reason for this is that the Office programs handle OLE in
different ways and ThermaCAM Researcher cannot work perfectly in all
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environments. This chapter describes some of the peculiarities and ways to work
around them. ThermaCAM Researcher works better in Office 95 than in previous
releases of the product. In Office 97 many problems seem to have disappeared.

9.2.1 Colours
Problem: In some applications, e.g. Microsoft Word, the image can be drawn
using the wrong colours. Instead of using the colours in the selected palette (e.g.
Rainbow) the image is drawn in randomly selected colours.

Solution: Change the settings for your video card so it uses more than 256 colours.
Depending on your video card, use 32000, 64000 or TrueColour. Please refer to the
documentation of your video card. Please note that this may affect the performance
of the live image presentation.

9.2.2 Incorrect aspect ratio
Problem: When you change the size of the IR image it can get incorrect
proportions, i.e. it becomes elongated either horizontally or vertically.

Solution: You have to avoid doing this. Different programs provide different
means of resizing an embedded object with out changing the aspect ratio. In some
cases you should catch the corners, in other cases you should press the shift button
while resizing the object.

9.2.3 Links will not work for an embedded object
Problem: If you have an embedded ThermaCAM Researcher, linking to a value in
it might not work.

Solution:

In Excel you can embed a ThermaCAM Researcher object and paste a link to a
value in the object. The problem is that when you deactivate the object, any
changes you have made to the image (added analysis etc.) will not be seen in the
inactive object. The image will be updated when you save the Excel document. A
solution to this problem is to link both the image and the value or to upgrade to
Office ’97.

9.2.4 Multiple links do not update in Word
Problem: If you have more than one link from the same IR image (e.g. one link
from the IR image and one link for a spot meter temperature) it might happen that
only one of links will be updated when you modify the IR image.
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Solution: The problem is that when the links shall be updated Word cannot handle
more than one link. The easiest solution to this problem is to select all text in Word
(press Ctrl + A) and then press F9 to update the entire document.

9.2.5 Word consumes lots of disk space for live images
Problem: If you embed ThermaCAM Researcher in Word and try to present a live
image, Word will get busy slowly filling your hard disk. Sometimes, it proves
impossible to do anything but restarting the computer.

Solution: Live image presentation in MS Word should be avoided. The lost disk
space is recovered when the computer is restarted.

9.2.6 Excel does not accept our numerical values
Problem: Under some circumstances, the Excel cells will refuse to accept numeric
values from ThermaCAM Researcher. This is due to the fact that ThermaCAM
Researcher will “decorate” the values with “<“, “>“ and “*” signs, if the
temperatures are out of range.

Solution: We recommend that you select a better measurement range in this case.
If that proves impossible, there is a possibility for you to switch off these
decorations altogether. Then, in the registry of your computer, set the following
parameter to 0 instead of 1 and restart ThermaCAM Researcher.

My computer\
   HKEY_CURRENT_USER\
      Software\
         FLIR Systems AB\
            ThermaCAM Researcher XXXX\
               Settings\
                  IllegalTempIndicator = 0

9.2.7 Activate method gives run time error 1004 in Excel
Problem: When used on an embedded object in Microsoft Excel for Office 97, the
Activate method under some circumstances gives runtime error 1004. This applies
to many embedded objects, not only ThermaCAM Researcher objects.

Solution: We recommend that you either avoid activating the object or create the
macro with an earlier version of Excel or update to Office 2000, which seems to
work better.
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10. Glossary

Ambient temperature
Ideally, all radiation received by the camera should come from the body you wish
to study. Other bodies and the air around it will also emit radiation which by
reflection can reach the camera, but it can be compensated for.  The effect of this
radiation is assumed to be the same all over the image. You should set this
parameter to the average temperature of the surroundings.

Atmospheric temperature
The air between the body you wish to study and the camera absorbs some of the
radiation passing through and adds some radiation due to its own temperature.
This disturbs the measurements, but it can be compensated for. You should set this
parameter to the average temperature of the atmosphere. The distance and relative
humidity also have to be correct in order for the compensation to work.

Blackbody
A body, which absorbs all radiation falling upon it at any wavelength. Such objects
do, despite their name, emit electromagnetic radiation due to their temperature.
The spectral distribution of the radiation from a blackbody follows the so called
Planck’s Law.

Many ordinary bodies behave almost like blackbodies, emitting radiation in the
same way, but less of it. Such objects are called greybodies.

See also: emissivity.

Camera interface
Name referring to the hardware through which the image passes before it reaches
the image handling software in the computer.

CardBus PC Card
PC Cards that comply to the new 32-bit version of the PC Card Standard.
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Clipboard
An area of storage, or buffer, where data objects or their references are placed
when a user carries out a cut or copy operation. The data is then usually pasted
into other applications.

Control panel
Windows with buttons, list selections, check boxes and so on with which you can
control some particular thing, for instance a camera. Your actions you have an
immediate effect.

Compound document
Or container document. A document within an OLE container application that
contains data of different formats, such as sound clips, spreadsheets, text, and
bitmaps. Each piece of integrated data (or compound-document object) can exist
within the compound document as a linked item or an embedded item.

Computed transmission
The program will attempt to compute the transmission of the atmosphere, if it is
air, based on facts about its temperature, humidity and the distance to the body
being studied. The value is used in compensating for the effects of the atmosphere
on the radiation passing through.

Dialogue window
A window meant for interaction with the user. It can be equipped with tabs,
buttons, text input fields, list selections, check boxes and so on. There is an OK
button, which you have to press in order to activate your changes and a Cancel
button by which you can discard them.

Directory
A system file used to maintain the structure of a set of files.

Distance
The distance between the front of the lens of the camera and the thing being
depicted.
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Docking
Tool bars can be docked, i.e. be attached to the borders of the main window,
following it as it is moved or resized. You double-click with the left mouse button
on the tool bar to release the docking. The freely floating toolbar then created can
be made to dock again by another double click with the mouse.

Embedded item
Or embedded object. A type of compound-document item in which all the
information needed to manage the item is stored in the container document, but
which is created and edited by an OLE server application. Embedded items can be
edited or activated in-place. See also linked item and in-place activation.

Emissivity
A number between 0 and 1 describing the amount of radiation emitted from a body
compared to if it was a perfect blackbody.

Estimated transmission
The program will attempt to compute the transmission of the atmosphere based on
facts about its temperature, humidity and the distance to the body being studied.
This value is used in compensating for the effects of the atmosphere on the
radiation passing through.

If you are able to obtain a better value you can set this parameter to that value,
thus improving the compensation. Set it to 0 to make the program use the computed
transmission.

External Optics
An IR-transparent material through which the camera is looking at the body being
studied. The program can compensate for the temperature and IR transmission
properties of this material, but not for reflections that appear in its camera-side
surface.

Frame grabber
Piece of hardware that captures images from an electrical stream of bytes.
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In-place activation
Or in-place editing, visual editing. The ability to activate an object within the
context of its container document, as opposed to opening it in a separate window.

IR
The infrared waveband in the electromagnetic spectrum. Roughly about 1 to 50 µm
wave length.

IR image file (.IMG, .ANA, .TIF, .T?W, .SEQ)
Extensions for files containing an IR image in digital format. Most IR image files
contain a substantial amount of information about the image in addition to the IR
value of each pixel. The IR values are mathematically transformed to temperature,
before any measurement or display is made. t?w stands for tmw, tgw and tlw.

ThermaCAM Researcher session file (.IRS)
File extension used for ThermaCAM Researcher session files, containing most of
the settings related to a particular “run” of ThermaCAM Researcher. If you save
your work in a session file, you should be able to come back to the same state when
retrieving the file. The most important element of the session is its list of current
image files and the name of their directory. The session files do not contain any
images as such and no analysis results from the images.

Link
A connection between two documents.

Linked item
Or linked object. In OLE, an item in a compound document whose data is stored in
a separate file rather than in the document's file. A linked item must be edited in a
separate window. See also embedded item.

Object
A much too frequently used word meaning either the motif of the IR image,
something in a screen window possible to activate by the mouse or a chunk of data
that can be transferred between programs.
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Object parameters
A group of values describing the body being investigated (the object) and its
surroundings. The values are used in a calculation which computes the amount of
radiation actually coming from the object. Compensations are made because the
atmosphere between the object and the camera absorbs and emits radiation, and
radiation being reflected in the object can reach the camera.

The object parameters are: Emissivity, Ambient temperature, Atmospheric
temperature, Relative humidity, Distance, External optics temperature and
External optics transmission.

In addition to these, there is also the Estimated transmission parameter, which
mainly is used when atmosphere does not consist (only) of air.

OLE
Stands for Object Linking and Embedding. A way to transfer and share
information between applications. Linking and embedding are two methods in OLE
for storing items inside a compound document when those items were created in
another application. An embedded item is stored as part of the compound
document that contains it. A linked item stores its data in a separate file.

OLE Automation
A way to manipulate an application's objects from outside the application. OLE
Automation is typically used to create applications that expose objects to
programming tools and macro languages, to create and manipulate one
application's objects from another application, or to create tools for accessing and
manipulating objects.

OLE Automation object
An object that represents (some of) the data and functionality of an application. It
can be changed by other applications using OLE Automation via “Properties” and
“Methods”. An application that exposes its OLE Automation objects is called an
OLE server application. The application that accesses the object is called the OLE
Controller application.

OLE Container application
An application that can incorporate embedded or linked items into its own
documents. The documents managed by a container application are able to store
and display OLE Visual Editing items as well as data created by the application
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itself. A container application allows users to insert new items or edit existing
items. See also OLE server application.

OLE Controller application
An application that can access and manipulate OLE Automation objects is called
an OLE controller application

OLE item
An object that represents data, created and maintained by a server application,
that can be seamlessly incorporated into a document so that the object appears to
be a part of the larger document. The result is a compound document made up of
the OLE item and a containing document.

OLE Server application
An application that can create OLE items for use by container applications. Data
in a server application can usually be copied, using the Clipboard or a drag-and-
drop procedure, so that a container application can paste the data as an embedded
or linked item. Also the name of applications that expose their data and
functionality for automation as OLE Automation objects.

OLE Server document
A document created by an OLE server application. See also compound document.

Palette
The set of colours used when painting the image.

Also, a text file with RGB colour codes. The extension is .pal.

PC Card
A memory or Input/Output card complying to the 16 bit PC Card Standard. Such
cards can be plugged into PC Card adapters of laptop and desktop computers.
They also fit into 32 bit PC Card adapters that are compatible with the same
standard.

PC Card adapter
A device designed to connect PC Cards to an internal bus of a PC.
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PCMCIA
An acronym for the Personal Computer Memory Card International Association
which decides on the PC Card Standard.

Pixel
Short for picture element. The IR image is made up of a number of dots (pixels),
each with its own temperature value and, consequently, colour. The pixel co-
ordinates are 0:0 at the top left corner of the image and increase towards the right
and downwards.

Relative humidity
A number between 0 and 99% which is used in the calculation of the computed
transmission of air. Air will absorb parts of the radiation passing through it, but
that can be compensated for.

Sequence of IR images
A set of IR images that have been recorded at the same time. Either in a number of
different .img files or in one single .seq file.

Tool bar
A bar-shaped window frequently containing small buttons with pictures. Other
types of controls can however also be used. Tool bar buttons issue a command
when you click on them with the mouse. Some buttons stay depressed, indicating
some kind of state, until you click again to release them or the state changes by
itself. Tool bar buttons can sometimes hide menus, that will appear when you move
the mouse during the click over the button. If you keep the mouse cursor still over a
tool button, an explanatory text, the tool tip, will appear.

Transmission
See Computed transmission and Estimated transmission.

VBA
An acronym for Visual Basic for Applications, a language used when writing
macro commands in modern Microsoft Applications.
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Wait state
The number of clock cycles that the processor in a PC will wait before proceeding
with the next operation towards a memory or Input/Output device.
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Creating stripe sets and formatting NTFS disks .................................................... 28
Csv......................................................................................................................... 96
Cursor, line ............................................................................................................ 84
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Distance ............................................................................................................37, 60
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How to make single image measurements............................................................. 80
How to measure many images ............................................................................. 100
How to play back images....................................................................................... 68
How to record IR images ....................................................................................... 64
How to set the camera type.................................................................................... 51
How to study temperature distributions ............................................................... 108
How to study temperature profiles....................................................................... 107
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Image directory...................................................................................................... 42
Image directory tool bar......................................................................................... 48
Image list ............................................................................................................... 42
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Image Settings dialogue, image ............................................................................. 62
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Image Settings dialogue, units ............................................................................... 94
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Image types............................................................................................................ 68
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Introduction.............................................................................................................. 7
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Isotherm................................................................................................................. 81

K

Keys - Shortcuts..................................................................................................... 49

L

Label, analysis ..................................................................................................62, 90
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MatLab................................................................................................................... 96
Matlab from selected images ................................................................................. 75
Measurement Range ...................................................................................53, 54, 56
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OLE caveats......................................................................................................... 115
OLE in brief......................................................................................................... 114
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Palette .................................................................................................................... 61
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PC Card Interface................................................................................................... 11
Play images tool bar..........................................................................................46, 72
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Quality assurance................................................................................................... 10
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Recommendations of PC ..................................................................................16, 27
Recording conditions dialogue .............................................................................. 66
Recording tool bar ............................................................................................47, 64
Reduce part of sequence ........................................................................................ 74
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Reducing selected images...................................................................................... 74
Removal of analysis tools ...................................................................................... 89
Remove part of sequence....................................................................................... 74
Removing all selected images................................................................................ 74
Removing some selected images ........................................................................... 74
Replay Settings ...................................................................................................... 73
Replay Settings dialogue........................................................................................ 73
Result table window............................................................................................... 91
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Save Tab As........................................................................................................... 96
Scaling ............................................................................................................61, 101
Scaling tool bar .................................................................................................48, 61
Screen layout ......................................................................................................... 44
Session files ........................................................................................................... 42
Shortcut keys ......................................................................................................... 49
Spot meter.............................................................................................................. 82
Standard tool bar.................................................................................................... 45
Stripe set ................................................................................................................ 28
Striped volume....................................................................................................... 29
Style, analysis tools................................................................................................ 89
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